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Preface

The C•CURE 9000OTIS Elevator System Integration Guide is for new and experienced security system users who
want to learn to use this product for the C•CURE 9000 Security Management System.

In this preface

How to Use this Manual 8
FindingMore Information 10
Conventions 11
Software House Customer Support Center 12



How to Use this Manual
This manual contains chapters and appendices that provide the following information about the C•CURE 9000
OTIS Elevator System integration:

Chapter 1: Introduction

This chapter describes the OTIS Elevator System integration and its features.

Chapter 3: Installation

This chapter provides the pre-installation requirements, installation procedure, licensing information, and the uninstall
procedure.

Chapter 2: OTIS Elevator System Configuration

This chapter provides the OTIS Elevator System Editor configuration procedures.

Chapter 4: OTIS Default Landing Matrix Configuration

This chapter provides the default landingmatrix configuration procedures.

Chapter 5: OTIS Landing Configuration

This chapter describes how to configure a landing (floor).

Chapter 6: OTIS DEC Clearance Landing Matrix Configuration

This chapter provides the DEC clearance landingmatrix configuration procedures.

Chapter 7: OTIS DEC Configuration

This chapter provides the DEC (Destination Entry Computer) configuration procedures.

Chapter 8: OTIS User Types

This chapter describes how to associate personnel to a User Type.

Chapter 9: OTIS Events and Actions

This chapter describes the OTIS events and the steps to configure them.



Chapter 10: Monitoring OTIS Elevator Activity

This chapter describes the C•CURE 9000Monitoring Station Activity Viewer and also provides the procedure to cancel
OTIS manual actions.

Chapter 11: Journal and Audit Messages

This chapter discusses the Journal and the Audit messages and how to locate them.

Chapter 12: Troubleshooting

This chapter helps to resolve problems youmay encounter with C•CURE 9000OTIS Elevator Integration.

Appendix A: Third-Party Copyright and Trademarks



Finding More Information
You can access C•CURE 9000manuals and online Help for more information about C•CURE 9000.

Manuals

C•CURE 9000 softwaremanuals are available in Adobe PDF format on the C•CURE 9000 installer. The available
C•CURE 9000 and Software Housemanuals are listed in theC•CURE 9000 Installation and UpgradeGuide.

Thesemanuals are also available from the Software House website (http://www.swhouse.com).

Online Help

You can access C•CURE 9000 Help by pressing F1 or clicking Help from themenu bar in the Administration/Monitoring
Station applications.

http://www.swhouse.com/


Conventions
This manual uses the following text formats and symbols.

Convention Meaning

Bold This font indicates screen elements, and also indicateswhen you should take a direct action in a procedure.

Bold font describesone of the following items:

• A command or character to type, or

• A button or option on the screen to press, or

• A keyon the keyboard to press

• A screen element or name

blue color text Indicatesa hyperlink to a URL, or a cross-reference to a figure, table, or section in this guide.

Regular italic font Indicatesa new term.

<text> Indicatesa variable.

The following items are used to indicate important information.

NOTE Indicates a note. Notes call attention to any item of information that may be of special importance.

TIP Indicates an alternatemethod of performing a task.

Indicates a caution. A caution contains information essential to avoid damage to the system. A caution
can pertain to hardware or software.

Indicates a warning. A warning contains information that advises users that failure to avoid a specific
action could result in physical harm to the user or to the hardware.

Indicates a danger. A danger contains information that users must know to avoid death or serious injury.



Software House Customer Support Center

Telephone Technical Support

During the period of the Agreement, the following guidelines apply:

■ Software House accepts service calls only from employees of the Systems Integrator of Record for the installation
associated with the support inquiry.

Before Calling

Ensure that you:

■ Are the Dealer of record for this account.

■ Are certified by Software House for this product.

■ Have a valid license and current Software Support Agreement (SSA) for the system.

■ Have your system serial number available.

■ Have your certification number available.

Hours NormalSupport Hours Monday through Friday, 8:00 a.m. to 8:00 p.m., EST. Except holidays.

EmergencySupport Hours 24 hours/day, seven daysa week, 365 days/year.

RequiresEnhanced SSA “7 x24” StandbyTelephone Support

(emergency) provided to Certified Technicians.

For all other customers, billable on time andmaterials basis.
Minimum chargesapply – SeeMSRP.

Phone For telephone support contact numbers for all regions, see http://www.swhouse.com/support/contact_technical_support.aspx.

http://www.swhouse.com/support/contact_technical_support.aspx
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Chapter 1 - Introduction

This chapter describes the OTIS System Elevator and the integration with C•CURE 9000.

In this chapter:

Overview 14
Features 15
Architecture 16
Terminology 18
OperationModes 19
ICD Version and Heartbeat Type Settings 21



Overview
TheOTIS Compass Elevator System integration with the C•CURE 9000 provides security to particular landings (floors) in
amulti-level building by ensuring that only those authorizedmay go to a particular landing, or exit on that landing. Access
to particular landings is determined through a swipe of a card to a card reader called a Destination Entry Computer (DEC)
outside of the elevator. The card reader accesses the personnel privilege assigned to a specific OTIS Elevator access
configuration.

HowOTIS Compass Integration Works

In a typical Destination Dispatching System (DDS) deployment, a C•CURE 9000 reader/keypad combination is deployed
in proximity to eachOTIS Destination Entry Computer (DEC) – a touch-screen or keypad device. AnOTIS DEC
communicates with anOTIS Destination Entry Server(DES) that manages a group of elevators. The C•CURE 9000
contains objects that represent the DER, DES, and DECs, including their relationships to Personnel,Clearances, and
Floors.



Features
TheOTIS integration with the C•CURE 9000 offers the following features:

■ Supports secured access to particular floors of multi-level building by ensuring that only the authorized personnel can
enter or exit on that floor.

■ Supports Multicast and Unicast Heartbeat Types.

■ Supports Interface Control Document (ICD) Version 1, Version 2, Version 2.2, Version 3, and Version 3.1.

NOTE It is recommended to configure all OTIS DES hardware with same ICD versions.

■ Supports OTIS Configuration user interface to configure ICD version and Heartbeat Type.

■ Supports the following Operational Modes which can also be scheduled.:

l Mode 1 - Default Floor Only

l Mode 2 - Access to Authorized Floors

l Mode 3 - User Entry of Destination Floor

l Mode 4 - User Entry of Default Floor

■ Supports floor selectionmessages for a DEC.

■ Supports Reason Codes for denied floor access.

■ Supports a Destination Entry Server (DES) Audit display that shows the elevator activity of Personnel.

■ Supports front and rear door configuration.

■ Supports the use of card swipe on the inbuilt reader of the DEC.

■ Supports Schedule-based floor access for all personnel.

■ Supports DEC PIN code entry. When this feature is enabled the customer can use PIN code entry to navigate to
floors in the building without needing to swipe their card.

■ Supports C•CURE 9000 event configuration based on elevator communication status.

■ Supports Remotemonitoring using the C•CURE 9000Monitoring Station.

■ Supports 255 floors by each elevator group, and the front and rear doors of each elevator cab.

■ Supports default floor configuration.

■ Supports Secure or unsecure floors through Events, Schedules, or Operator menus.

■ Supports the assigning of an exemption group who can access secured floors.

■ Supports Maintenancemode, which is used to limit information about an object, displays on theMonitoring Station.

■ Supports 15 DES per C•CURE Server and 25 DEC per DES. Please refer C•CURE Release Note for information on
detailed performance results.

■ Supports TLS 1.2 for security.

■ Supports multiple iStar doors configuration through iStar Doors tab under DEC object.



Architecture
The architecture of the OTIS Elevator Integration shows how the C•CURE 9000 security system interacts with the OTIS
Elevator Destination Entry System. The following images depict the relationship between theOTIS Elevator system and
C•CURE 9000.

Figure 1:  C•CURE9000OTISElevator Integration Architecture (with iSTAR Controller)



Figure 2:  C•CURE9000OTISElevator Integration Architecture (without iSTAR Controller)



Terminology
Table 1 on Page 18 describes the terms and their definitions related to the OTIS Elevator System integration.

Table 1:  OTISElevator System Integration Terminology

Term Definition

DDS Destination Dispatching System. TheOTIS system used to processpassenger input and route traffic to elevators.

DER Destination EntryRedirector. TheOTIS name for the device that connects all elevator groupsand allows the routing of passengers
fromDECs in a common area to anyelevator groups in a building.

DES Destination EntryServer. TheOTIS name for the device that controls the routing of passengers to a group of elevators.

Allowed
Floors

Allowed Floors are OTIS floor numbers that are designated at a DEC asaccessible without a credential.

Authorized
Floors

Authorized Floors are floors that are specifically identified asaccessible in a Personnel credential. Authorized Floors are defined in
C•CURE9000 by including them in a Clearance and assigning the clearance to a Personnel record.

DEC Destination EntryComputer. ADEC is a touch screen or keypad device that is used for passenger interaction with the OTIS
System.

ICD Interface Control Document

PIN Personal Identification Number



Operation Modes
C•CURE 9000OTIS Compass Integration supports the four Operational Modes available with the OTIS Compass
Destination Entry System. You specify the Operational mode used for anOTIS DEC on theOTIS DEC Editor General
tab.

Default Floor (Operation Mode 1)

In this operationmode, each authorized cardholder has been assigned a default floor, and certain floors may have been
designated as Allowed Floors (public access is allowed without a credential).

A potential passenger presents a credential at a C•CURE 9000 credential reader and it is interpreted by the C•CURE
9000, or a potential passenger enters a destination floor at the DEC.

This activity results in one of the following responses:

■ If a credential was presented and validated, a default floor for the passenger is transmitted to the DEC from C•CURE
9000, the DEC forwards the request to the DES for a car assignment., and displays that car assignment to the
passenger.

■ If C•CURE 9000 determines that the credential is invalid or the destination entered is not allowed, then C•CURE
9000 transmits this information to the DEC, and the DEC displays amessage informing the potential passenger that
the destination request has been denied.

■ If the destination request is allowed by the DEC, the DEC forwards the request to the DES for a car assignment, and
displays that car assignment to the passenger.

Access to Authorized Floors (Operation Mode 2)

In this operationmode, each authorized cardholder has been assigned Clearances that provide access to specific floors.
A potential passenger presents a credential at a C•CURE 9000 credential reader and selects a destination floor at the
OTIS DEC. C•CURE 9000 interprets the credential and transmits to the OTIS DEC an admit message along with a list of
authorized floors, or a reject message.

This activity results in one of the following responses:

■ The credential holder is given a car assignment by the DEC because their credential and their destination floor
request were valid.

■ The DEC displays a rejectionmessage and informs the passenger that they should seek assistance.

User Entry of Destination Floor (Operation Mode 3)

In this operationmode, the potential passenger selects a destination floor. This may be performed with or without the
presentation of a credential to C•CURE 9000.

This activity results in one of the following responses:

• The passenger's requested floor is accepted without C•CURE 9000 authorization, the DEC forwards the request
to the DES for a car assignment, and displays that car assignment to the passenger.

• If the passenger presented a credential to C•CURE 9000, their Authorized Floors are transmitted to the DEC from
C•CURE 9000, and if their requested floor is authorized, the DEC forwards the request to the DES for a car
assignment, and displays that car assignment to the passenger.

• If C•CURE 9000 informs the DEC that the credential and/or the requested floor is invalid, the DEC displays a
message informing the potential passenger that the destination request has been denied.



Default Floor or User Entry of Destination Floor (Operation Mode 4)

In this operationmode, the potential passenger presents a credential to the C•CURE 9000 Reader. Within a timeout
period (specified on the DDS Editor General tab), the passenger may override the default floor and choose another
destination floor. The timeout period is based on Personnel record settings in C•CURE 9000, as transmitted to the Otis
DEC. If the passenger is a Standard Passenger then the timeout period is 3 seconds. If the passenger is identified in
C•CURE 9000 as requiring Alternate Shunt for Americans with Disabilities Act (ADA) compliance, then the timeout is 6
seconds.

This activity results in one of the following responses:

• C•CURE 9000 transmits the passenger's Default and Authorized Floors to the DEC, the DEC forwards the
request to the DES for a car assignment, and displays that car assignment to the passenger.

• C•CURE 9000 informs the DEC that the credential and/or the requested floor is invalid, and the DEC displays a
message informing the potential passenger that the destination request has been denied.



ICD Version and Heartbeat Type Settings
OTIS Configuration allows you to set ICD Versions and Heartbeat Types for communicating with the OTIS Elevator
Server (DES). OTIS Configuration settings determines which ICD Version and Heartbeat Type is used for the OTIS
Integration.

This configuration is pre-configured, and default ICD Version is set as 3.1 and default Heartbeat Type is set as Multicast.
For more information see, Updating the OTIS Configuration for the OTIS Integration on Page 21

NOTE It is recommended to configure ICD Version and Heartbeat Type before configuring the OTIS Elevator
objects.

NOTE ICD Version 1.0 does not support the following features:

• Audit messages

• PIN code entry

• Rear doors for elevators

Updating the OTIS Configuration for the OTIS Integration

OTIS Configurations determines which ICD Version and Heartbeat Type is used for the OTIS Integration.

To Update the OTIS Configuration for the OTIS Integration

1. In the Administration Station, on theHardware pane, expand theCompany Name folder.

2. Right click theOTIS Configuration and select Edit.

3. Select the required ICD version from the ICD Version dropdown and Heartbeat Type from theHeartbeat Type
dropdown.

4. Click Save and Close.

Any changes youmake, occurs immediately, and do not require a driver restart to take effect.



Figure 3:  OTISConfiguration - OTIS Integration

Refer to Table 2 on Page 22 for the configured ICD Versions and Heartbeat Types.
Table 2:  Supported combinationsof ICD Version and Heartbeat Type

Serial Number ICD Version Heartbeat Type

1 1 Multicast

2 2 Multicast

3 2.2 Multicast

4 2.2 Unicast

5 3 Multicast

6 3.1 Multicast

7 3.1 Unicast

NOTE l Option to configure ICD Versions through System Variable is no longer supported.

l Changing the ICD Versions (or) Heartbeat Types (or) both the settings together will result in the
loss of communication with DES and DECs configured in the systemmomentarily but after a few
seconds (approx 5-7 seconds), communication re-establishes automatically.
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Chapter 2 - OTIS Elevator System Configuration

This chapter describes how to setup the OTIS Elevator System using the OTIS Elevator System Editor.

In this chapter:

Creating anOTIS Elevator System Folder 24
Accessing the OTIS Elevator System Editor Dialog Box 25
OTIS Elevator System Editor Dialog Box 26
Landing Tab 31
Triggers Tab 32
Status Tab 35
Override Tab 37
State Images Tab 39



Creating an OTIS Elevator System Folder

To Create a New OTIS Elevator System Folder

1. Double-click the AdministrationWorkstation icon on the desktop to open it.

(Alternately, you can select All Programs>Tyco>C•CURE 9000>Administration Station.)

2. Click theHardware pane button.

3. Right-click Hardware under the Hardware tree and select Hardware Folder>New.

4. Enter a name and description (optional) for the OTIS Elevator System folder.

5. Click Save and Close.

The new folder is listed under the Hardware tree.



Accessing the OTIS Elevator System Editor Dialog Box
This section explains how to access the OTIS Elevator System in the C•CURE 9000.

NOTE This section assumes that you already created a folder for the OTIS Elevator System. See
Creating anOTIS Elevator System Folder on Page 24 for more information.

To Access the OTIS Elevator System Editor

1. Open the C•CURE 9000 Administration Station.

2. Click theHardwarePane.

3. Click the Hardware drop-downmenu and select Hardware Folder.

4. Right-click the OTIS Elevator System folder and select OTIS Elevator System>New, as shown in Figure 4 on Page
25.

Figure 4:  Access theOTIS Elevator SystemDialog Box

TheOTIS Elevator System dialog box, shown in Figure 5 on Page 27, opens with the General tab selected.



OTIS Elevator System Editor Dialog Box
TheOTIS Elevator System Editor dialog box, shown in Figure 5 on Page 27, is used to create an identity for the elevator
system, select the DES or DER option, enter IP addresses for the primary and backup servers, configure triggers and
events, view configured Landings in the elevator group, and optionally change state images..

For more information on DES and DER, see the following:

■ Destination Entry Server (DES) on Page 26

■ Destination Entry Redirector (DER) on Page 26

Destination Entry Server (DES)

AnOTIS DES is a Destination Entry Server that supports the DECs (Destination Entry Computers) for a group of
elevators. In the OTIS Elevator System, there are two DES to configure. One DES acts as a primary server (Server A)
and the other as a backup server(Server B) in case the primary encounters a problem and cannot serve its intended
function. The backup server is provided in the event that it is needed as a fail-over device.

Destination Entry Redirector (DER)

AnOTIS DER is a Destination Entry Redirector, an optional server type, whose function is to support building-wide DEC
devices. The DER connects to all elevator groups and allows DEC’s at a common entry point in the building, for example
in a Lobby, to accept destination requests for any floor in the building.

For more information, see the following:

■ Accessing the OTIS Elevator System Editor Dialog Box on Page 25

■ OTIS Elevator System Editor Dialog Box Definitions on Page 27

■ OTIS Elevator System Editor Tasks on Page 28

■ OTIS Elevator System Editor Tabs on Page 28



Figure 5:  OTIS Elevator SystemEditor Dialog Box

OTIS Elevator System Editor Dialog Box Definitions

Table 3 on Page 27 describes the OTIS Elevator System Editor dialog box fields and buttons.

Field/Button Description

Name Aunique name identifying theOTIS elevator system.

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Description Optional. A description for the OTIS elevator system.

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Table 3:  OTISElevator SystemEditor Dialog BoxDefinitions



Field/Button Description

Save and Close Saves the configuration and closes the dialog box.

General Tab

Device Type Choose either DER or DES from the drop-down list.

TCP/IP Options

For Device Type-DES Set the uniqueServer A IP Address.

Server B IP addresswill update accordingly byusing the same subnet third
addressas you chose for the Primary IPAddress.

For Device Type-DER Set the unique Server A IP Address.

Table 3:  OTISElevator SystemEditor Dialog BoxDefinitions (continued)

OTIS Elevator System Editor Tabs

The following sections provide information about the OTIS Elevator System Editor tabs:

■ Landing Tab on Page 31

■ Triggers Tab on Page 32

■ Status Tab on Page 35

■ Override Tab on Page 37

■ State Images Tab on Page 39

OTIS Elevator System Editor Tasks

This section describes the tasks performed in the OTIS Elevator System Editor Dialog box.

The following tasks are performed in the OTIS Elevator System Editor dialog box - General tab:

■ Creating anOTIS Elevator System on Page 28

■ Creating anOTIS Elevator System Template on Page 29

■ Editing anOTIS Elevator System on Page 29

■ Viewing OTIS Elevator System Configurations on Page 30

■ Deleting anOTIS Elevator System on Page 30

Creating an OTIS Elevator System

To Create an OTIS Elevator System

1. Open the C•CURE 9000 Administration Station.

2. Click theHardware pane.



3. Click the drop-downmenu located under Hardware and select Hardware Folder.

4. Right-click the folder you created in the Hardware tree and select OTIS Elevator System>New.

(Alternately, you can create a new folder by clicking onNew located next to the Hardware drop-downmenu.)

NOTE OTIS Elevator System is used for the folder name throughout this guide.

TheOTIS Elevator System Editor opens. SeeOTIS Elevator System Editor Dialog Box on Page 26

5. Enter a name for the elevator group in theName field.

6. Enter a description (optional) for the elevator group in theDescription field.

7. Click theGeneral tab and perform the following:

a. Enter the IP address of the primary OTIS Group Controller in theServer A field.

b. Enter the IP address of the backupOTIS Group Controller in theServer B field.

8. Click Save and Close.

The Elevator System is listed under the OTIS Elevator System folder in the Hardware tree.

9. Go to OTIS Default LandingMatrix Dialog Box on Page 56 to configure the default landingmatrix.

Creating an OTIS Elevator System Template

Creating a template saves you time because you do not have to re-enter the same information again.

To Create a Template

1. Click theHardware pane.

2. Click the drop-downmenu located under Hardware and select Hardware Folder.

3. Right-click the OTIS Elevator System folder in the Hardware tree and select OTIS Elevator System>New
Template.

4. Enter the information for the OTIS Elevator System template.

5. Click Save and Close.

The new template is listed underOTIS Elevator System>Templates.

Editing an OTIS Elevator System

To Edit an OTIS Elevator System

1. Double-click the Elevator System under the OTIS Elevator System folder in the Hardware tree to open the
OTIS Elevator System dialog box.

(Alternately, you can right-click the Elevator System and select Edit from the context menu.)

2. Make the changes to the configuration.

3. Click Save and Close.



Viewing OTIS Elevator System Configurations

To View OTIS Elevator System Configurations

1. Select OTIS Elevator System from theHardware drop-downmenu.

2. Click the green right arrow to open a Dynamic View displaying all OTIS Elevator System Configurations.

TheOTIS Elevator System tab opens in the Dynamic View displaying a list of OTIS Elevator System configurations

Deleting an OTIS Elevator System

To Delete an OTIS Elevator System

1. Click the Elevator System under the OTIS Elevator System folder in the Hardware tree.

2. Click a Landing to expand the DEC configurations.

3. Right-click the DEC configuration and select Delete from the context menu.

4. Repeat step 3 for all DEC configurations listed under the Landing.

5. Right-click the Landing and select Delete from the context menu.

6. Right-click the Elevator System and select Delete from the context menu.



Landing Tab
The Landing tab, shown in Figure 6 on Page 31, lists the configured Landings (floors) for the elevator group. This tab is
read-only.

Figure 6:  OTIS Elevator SystemEditor – Landing Tab



Triggers Tab
The Triggers tab, shown in Figure 7 on Page 32, is used to configure triggers to activate events.

Triggers are used by C•CURE 9000 to activate specific actions when a particular predefined condition occurs. Once the
Elevator status matches one of these values, the linked Activate Event action is triggered and the user-specified event is
set to an active state (if allowed by the event, which should be armed at the time). Typically, you would use the activated
event to sendmessages to a security guard or administrator when an elevator has a particular status.

By creating new rows and selecting different values for each row, each value of the Status field can trigger its own event.
It is also possible to trigger two different events for the same status value by creating two rows with the same value and
then linking each row to its own event.

For more information, see the following:

l Triggers Tab Definitions on Page 33

l Triggers Tab Tasks on Page 33

Figure 7:  OTIS Elevator SystemEditor – TriggersTab



Triggers Tab Definitions

TheOTIS Elevator System Editor – Triggers tab fields and buttons are described in Table 4 on Page 33

Field/Button Description

Add Click this button to create a new row in the Triggers table. Youmust configure all fields in the row to complete the Add operation.

Remove Click this button to remove a selected row from the Triggers table.

Property
Click in the Property column, and then click . The Property browser openspresenting properties available for the OTIS
ElevatorsSystem.

• BackupCommunicationStatus- The current CommunicationsStatusof Server BController

• CommunicationStatus - The current CommunicationsStatusof Server AController

Click the Property to select it and add it to the column.

Value Selectionsare Online andOffline.

Action Click the drop-downmenu to select an action to occur. This action selected will occur when the object's selected Property
receives the selected Value.

Details The name of the event configured for the row (read-only) entered by the system.

Event
Click the selection button to select a Event that you want to associate with the trigger. Events are created in the C•CURE
9000 Configuration pane. See theC•CURE9000 Software Configuration Guide for more information.

Table 4:  OTISElevator SystemEditor Dialog Box–TriggersTab Definitions

Triggers Tab Tasks

The following tasks are performed in the Triggers tab:

l Selecting Triggers to Activate Events on Page 33

l Deleting Triggers and Events on Page 34

Selecting Triggers to Activate Events

To Select Triggers to Activate Events

1. Click the Triggers tab.

2. Click theAdd button.

3. Click in the blank row underProperty, and then click the selection button to open theOTIS Elevator System
dialog box.

4. Click BackupCommunicationStatus (for Server B) orCommunicationStatus (for Server A) to select it.

5. Click in the blank field underValue.

6. Click the drop-downmenu and select Offline orOnline.

7. Click the drop-downmenu underAction and select Activate Event.

The Event field appears at the bottom of the dialog box.



8. Click the selection button .

9. Click a pre-configured event to activate.

10. Click Save and Close.

Deleting Triggers and Events

To Delete a Trigger and Event from the Elevator Group

1. Click the row selector button to select the row.

2. Click theRemove button.



Status Tab
The Status tab, shown in Figure 8 on Page 35, provides read-only information about the operational status of Server A
(primary server) and Server B (backup server) used by the OTIS Elevator system.

Supported values are:

■ Online

■ Offline

■ Unknown

Formore information, see the following:

■ Status Tab Descriptions on Page 35

Figure 8:  OTIS Elevator SystemEditor – StatusTab

Status Tab Descriptions

TheOTIS Elevator System Editor–Status tab fields are described in Table 5 on Page 36.



Field/Button Description

Server ACommunication Status Value (Status):

• Online: TheOTISElevator System is configured and communicating with the primaryOTIS
server (Server A).

• Offline: TheOTIS Elevator System is configured, but not communicating with the primary
OTIS server (Server A).

• Unknown: The status cannot be determined, usually displayed after the initialOTISElevator
System configuration while waiting for the primaryOTIS server (Server A) to update the
status .

Server BCommunication Status Value (Status):

• Online: TheOTISElevator System is configured and communicating with the secondary
OTIS server (Server B).

• Offline: TheOTIS Elevator System is configured, but not communicating with the secondary
OTIS server (Server B).

• Unknown: The status cannot be determined, usually displayed after the initialOTIS Elevator
System configuration while waiting for the secondaryOTIS server (Server B) to update the
status.

Table 5:  StatusTab Definitions



Override Tab
TheOverride tab, shown in Figure 9 on Page 37, is used to select a pre-configured personnel group that will be exempt
from themanual secure landing action. The selected exempt personnel group allows the personnel in the group access to
the landing when it is in the secured state.

For more information, see the following:

■ Override Tab Definition on Page 37

■ Selecting an Exempt Personnel Group on Page 38

Figure 9:  OTISElevator SystemEditor - Override Tab

Override Tab Definition

Table 6 on Page 37 describes the Override tab field.

Field Description

Exemption Group
Click the selection button to select the pre-configured personnel group. See theC•CURE 9000 Software
Configuration Guide for information on creating personnel groups.

Table 6:  OTISElevator SystemOverride Tab Dialog BoxDefinitions



Selecting an Exempt Personnel Group

To Select n Exempt Personnel Group

1. Click theOverride tab.

2. Click the selection button locate to the right of Exemption Group. TheGroup selection box opens.

3. Click in the row below theName column.

4. Click the drop-down arrow to select the exempt personnel group.

5. Click Save and Close to save the configuration.



State Images Tab
The State Images tab, shown in Figure 10 on Page 39 displays the current elevator system images that display in the
Monitoring Station to represent activities concerning the elevator system. You can select other images to display for this
elevator system or return back to the default images, as described in this section.

See State Images Tab Tasks on Page 67 for information about changing the state images.

Figure 10:  OTIS Elevator SystemEditor – State ImagesTab

State Images Tab Tasks

The following tasks are performed in the State Images tab:

■ Replace a State Image on Page 39

■ Restore the Default State Image on Page 40

Replace a State Image

To Replace an Image

1. Double-click the default image in the tab to open aWindows file selection dialog box.

2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.



The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

To Restore the Default Image

■ Right-click the image in the State Images tab and select Restore Default.
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Chapter 3 - Installation

This chapter explains how to install the OTIS Elevator System Integration. It also explains how to uninstall OTIS Elevator
System Integration.

In this chapter

Installation Overview 42
Before You Begin 43
Installation 44
Licensing 49
Starting the Server Services 50
OTIS Configuration File 51
Uninstall 53



Installation Overview
The C•CURE 9000 softwaremust be installed before the OTIS Elevator integration software is installed. For information
on installing C•CURE 9000, see theC•CURE 9000 Installation and UpgradeGuide.

Similar to the C•CURE 9000 system, the OTIS Elevator Integration has client and server components. Youmust install
the client components on every computer that runs C•CURE 9000 client applications, and youmust install the server
components on the C•CURE 9000 server computer. TheOTIS Elevator Integration has the same hardware, software,
and disk space requirements as C•CURE 9000; if the target computer meets the requirements for the C•CURE 9000,
then it meets the OTIS Elevator Integration requirements.

The installation wizard prompts you to install the OTIS Elevator Integration software. Youmust perform the basic
installation process on each computer in your C•CURE 9000 security system. Be sure to close all C•CURE 9000 and
virus--checking applications on client workstations before performing the installation.

Table 7 on Page 42 provides an overview of the steps to install and register the OTIS Elevator System on each computer
in your C•CURE 9000 security system.

Table 7:  Installation TasksOverview

Task See...

1. Install C•CURE9000, if not already installed. C•CURE9000 Installation and
UpgradeGuide

2. Ensure that the Pre-installation requirements aremet. Before You Begin on Page 43

3. Install the OTISElevator System Integration software. Installation on Page 44

4. If you did not select to start the C•CURE9000 servicesduring the installation, start the C•CURE9000
servicesand theOTISElevator Driver Service.

Installation on Page 44

5. Verify that a license exists for the OTISElevator System. Licensing on Page 49

Table 8 on Page 42 provides the installation information on aMAS (Master Application Server) and SAS (Satellite
Application Server) environment.

Table 8:  Installation on aMAS/SAS

Installation on a .... Installs...

MAS (Master Application Server) Nothing is installed.

Installation on aMAS is not supported.

MAS remote client and anyother client systems • Only the OTISElevator System client objects are installed.

• No server or database objects are installed.

SAS (Satellite Application Server) AllOTISElevator System components and the database are installed.

SAS remote client and anyother client system • Only the OTISElevator System client objects are installed.

• No server or database objects are installed.



Before You Begin
You should perform the following pre-installation steps described below:

Pre-installation Steps

■ If you are installing OTIS Elevator System Integration on a corporate network, be sure to coordinate with your
corporate network administrator.

■ To perform the installation, youmust have the appropriateWindow's permissions. Youmust be in the local
Administrators group, or have equivalent privileges. See theMicrosoft Operating System documentation or your
system administrator for more information.

■ Ensure that you have two NIC (Network Interface Card) cards on the system

• OneNIC to communicate with the Access Control System

• OneNIC to communicate with the OTIS Elevator system.



Installation

To Install the OTIS Elevator Integration

1. Log into the Server or Client with Administration privileges.

2. Map to a shared drive over the network.

3. Go to http://www.swhouse.com/Support/Default.aspx.

4. Click Software Downloads.

5. Click "Software House Connected".

6. Scroll down toOtis Elevator.

7. Download the OTIS Integration software to a folder on the shared drive.

Running the Setup Program

To Run the Installation Program

NOTE Before installing the OTIS Elevator Integration, follow the below steps:

1. Close the C•CURE 9000 Administration Station andMonitoring Station.

2. Open the C•CURE 9000 Server Configuration Application and stop the following server services:

l CrossFire Framework Service

l CrossFire Server Component Framework Service

3. Close the C•CURE 9000 Server Configuration Application.

1. Navigate to the folder where you downloaded theOTIS integration software.

2. Extract the OTIS integration files from the zip file you downloaded to a directory.

3. Click Release folder

4. Right-click OTIS_Integration.exe and select Run as Administrator.

TheOTIS Integration Setup dialog box, shown in Figure 11 on Page 45, opens.

http://www.swhouse.com/Support/Default.aspx


Figure 11:  OTIS Integration Setup Dialog Box

5. Click the I accept the terms in the license agreement check box, and then click Install

The Tyco CrossFire Service Alert dialog box, shown in Figure 12 on Page 45, appears if you are installing the OTIS
Elevator System Integration on a C•CURE 9000 server and the CrossFire service is running.

When the CrossFire services are stopped the Tyco CrossFire Service Alert dialog box does not appear.

Figure 12:  Preparing to Install Dialog Box

6. Click OK to continue with the installation.
TheOTIS Integration SetupWizard, shown in Figure 13 on Page 46 appears.



Figure 13:  OTIS Integration SetupWizard

7. Click Next to select the Installation Options, shown in Figure 14 on Page 46.

8. If you are installing the driver in a redundancy environment, then select theRedundant server installation using
supported third party redundancy option and the enter theVirtual server (alias) name of the Redundant
Environment.

Figure 14:  Installation Options

9. Click Next.

The Ready to Install OTIS Integration dialog box, shown in Figure 15 on Page 47, appears.



Figure 15:  Database Server Dialog Box

10. Click Install to start the installation or click Back to change the installation settings. Once installation is completed,
Completed the OTIS Integration SetupWizard, shown in Figure 16 on Page 47, appears. This operationmay take a
few minutes.

Figure 16:  Completed theOTIS Integration SetupWizard

11. Click Finish to exit the SetupWizard.
The Setup Successful dialog box, as shown in Figure 17 on Page 48, opens.



Figure 17:  Setup Successful dialog box

12. Click Close to exit the OTIS Installation.

NOTE If you did not select the installation option to provide the virtual server (alias) name, or
provided the wrong alias name, for the redundancy environment:

1. Open theOTISElevatorDriverService.exe.config file located in
.../Tyco/CrossFire/ServerComponents.

2. Under the client section in the file, change ‘localhost’ to the alias name of the redundant
environment for all the endpoint names except for the endpoint
name="TraceViewerURI".”



Licensing
You need a license to use the C•CURE 9000OTIS Elevator Integration software. Please contact your local Software
House Sales Representative.

To Verify that you have an OTIS License

1. Double-click the Licensing icon on your desktop to open the C•CURE 9000 License dialog box.

(Alternately, you can select All Programs>Software House>Licensing.)

2. Click theOptions tab.

3. Scroll down the list to verify that Otis Elevator Destination Dispatching System is listed.



Starting the Server Services
Before you can configure the OTIS Elevator integration object, the CrossFire Framework Service, CrossFire Server
Component Framework Service, and the OTIS Elevator Driver Integration Servicemust be running.

To Start the Server Services

1. From the Start Menu, select Start>All Programs>Tyco>C•CURE 9000>Server Configuration. The Server
Configuration Application opens.

2. Click theServices tab.

3. If the Status is displayed as “Stopped” for the CrossFire Framework Service under Framework Services, click Start.

4. If the Status is displayed as “Stopped” for the CrossFire Server Component Framework Service under Framework
Services, click Start.

Wait until the CrossFire Framework Service and CrossFire Server Component Service display a status of “Running”.

5. If the Status is displayed as “Stopped” for the OTIS Driver Service under Extension Services, click in theEnabled
check box and then click Start.

When the status of the OTIS Driver Service changes to Running you can use theOTIS Elevator System Integration
software.

NOTE When theOTIS Driver Service is stoppedmanually, it is recommended to start the service again after a
minimum of 2minutes duration is elapsed.



OTIS Configuration File
TheOTIS configuration file is located at Tyco/CrossFire/ServerComponents. This section describes the values that
you can change in the OTIS configuration file:

NOTE If youmake any changes in the configuration file youmust restart the driver.

Ensure that you change the values only after consulting with the product support team.

SSIpAddress – This is the local IP Address of Security System (SS).

MulticastIpAddress - This is theMulticast Group IP address.

SSReceiveUnicastPortNumber4mDES – This is the port number of SS at which SS receives Unicast messages from
DES. The default port number is 45303.

SSSendUnicastPortNumber2DES - This is the port number of DES at which SS sends Unicast messages to DES. The
default port number is 46303.

SSReceiveMulticastPortNumber4mDES - This is the port number of SS at which SS receives Multicast message from
DES for the V2 protocol. The default port number is 47307.

DESMulticastPortNumber - This is the port number of DES at which SS sends Multicast messages to DES for the V2
protocol. The default port number is 48307.

SSReceiveMulticastPortNumber4mDESV1 - This is the port number of SS at which SS receives Multicast messages
from DES for the V1 protocol. The default port number is 45307.

DESMulticastPortNumberV1 - This is the port number of DES at which SS sends Multicast messages to DES for V1
protocol. The default port number is 46307.

SSReceiveUnicastPortNumber4mDEC - This is the port number of SS at which SS receives Unicast messages from
DEC. The default port number is 46308.

SSSendUnicastPortNumber2DEC - This is the port number of DES at which SS sends Unicast message to DEC. The
default port number is 45308.

SSReceiveUnicastHeartbeatPortNumber4mDES - This is the port number of SS at which SS receives Unicast
Heartbeat message from DES for ICD versions 2.2/3.1. The default Port number is 53307.

DESUnicastHeartbeatPortNumber - This is the port number of DES at which SS sends Unicast Heartbeat message to
DES for ICD versions 2.2/3.1 . The default Port number is 54307.

RetryTimeOutMilliseconds - Use this variable to specify the duration between the retries. The default value is 1000
milliseconds.

NumberOfRetries - Use this variable to specify the number of times amessagemust be retried. The default value is 3.

ESHeartbeatIntervalinMiliseconds – Use this variable to define the regular intervals, in milliseconds, to send a
HeartBeat. The default value is 1000milliseconds.

HBOfflineChkRetryInterval - Use this configuration to specify the duration that is used for setting the communication
status of the elevator server. It must be less than the 'HeartBeatTimeOut' configuration value. The default value is 2000
milliseconds.



HeartBeatTimeOut - Use this configuration to specify the timeout value for the Heartbeat, which would be compared with
the last successful Hearbeat received time from Elevator server to driver, to set the communication status of the elevator
server. The default value is 5000milliseconds.

TTL - Use this variable to specify the time to live value for Heartbeat. The default value is 5.



Uninstall
This section describes how to uninstall the OTIS Elevator System integration on aWindows 7 operating system. For
additional operating systems, please refer to your Microsoft Windows documentation for instructions to access the Add
and Remove programs.

To Uninstall the OTIS Elevator System

1. Close the C•CURE 9000 AdministrationWorkstation and theMonitoring Station.

2. Open the C•CURE 9000 Server Configuration Application, and stop the following server services:

l CrossFire Framework Service

l CrossFire Server Component Framework Service

l OTIS Driver Service

3. Close the C•CURE 9000 Server Configuration Application.

4. Open theWindows Control Panel.

5. Select Programs and Features.

6. Right-click C•CURE 9000 - OTIS Elevator Integration and select Uninstall.

The C•CURE 9000OTIS Integration SetupWizard dialog box opens.

7. Click Next. TheOTIS Integration Setup dialog box opens. This setup wizard allows you to remove theOTIS
Integration.

8. Click Next. Ready to removeOTIS Integration dialog box appears.

9. Click Remove to removeOTIS Integration.

10. (Optional) Click in theDrop the OTIS Integration database tables check box to remove theOTIS tables from the
database. Completed the OTIS Integration Setup Wizard appears.

11. Click Finish. Setup Successful dialog box appears.

12. Click Close to complete the uninstallation process.
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Chapter 4 - OTIS Default Landing Matrix Configuration

This chapter describes how to configure a default landing using the OTIS Default LandingMatrix dialog box.

In this chapter

Accessing the OTIS Default LandingMatrix Dialog Box 55
OTIS Default LandingMatrix Dialog Box 56



Accessing the OTIS Default Landing Matrix Dialog Box
This section describes how to access the OTIS Default LandingMatrix dialog box.

To Access the Dialog Box

1. Open the C•CURE 9000 Administration Station.

2. Click theHardwarePane.

3. Click the Hardware drop-downmenu and select Hardware Folder.

4. Right-click the OTIS Elevator System folder and select OTIS Default Landing Matrix>New, as shown in Figure 18
on Page 55.

(Alternately, you can right-click theOTIS Default Landing Matrix icon and select New.)

Figure 18:  Access theOTISDefault LandingMatrixDialog Box

TheOTIS Default LandingMatrix dialog box, as shown in Figure 19 on Page 56, opens.



OTIS Default Landing Matrix Dialog Box
LandingMatrix is a collection of landing (floors) that an OTIS elevator system supports. OTIS has two types of Landing
Matrices. Default LandingMatrix and Clearance Default LandingMatrix. TheOTIS Default LandingMatrix dialog box,
shown in Figure 19 on Page 56, is used to configure a common access LandingMatrix with no personnel clearances.

NOTE Youmust create a landing in C•CURE, in-order to dispatch the Landingmatrix.

For more information, see the following:

■ Accessing the OTIS Default LandingMatrix Dialog Box on Page 55

■ OTIS Default LandingMatrix Dialog Box Definitions on Page 56

■ OTIS Default LandingMatrix Tasks on Page 57

Figure 19:  OTIS Default LandingMatrixDialog Box

OTIS Default Landing Matrix Dialog Box Definitions

TheOTIS Default LandingMatrix dialog box fields and buttons are described in Table 9 on Page 57.



Field/Button Description

Name Aunique name identifying the default landingmatrix configuration.

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Description Optional. A description for the default landingmatrix configuration.

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Save and
Close

Saves the configuration and closes the dialog box.

Front

Landing
Matrix

Select the front doors of the floors to be included in the configuration.

• Checked indicates selected.

• Unchecked indicatesnot selected.

Valid range is between -127 to 127

Rear

Landing
Matrix

Select the rear doors of the floors to be included in the configuration.

• Checked indicates selected.

• Unchecked indicatesnot selected.

Valid range is between -127 to 127.

Table 9:  OTISElevator SystemDefault Landing Dialog BoxDefinitions

NOTE For ICD Version V1.0, Rear floor selection is not supported.

OTIS Default Landing Matrix Tasks

This section describes the following tasks.

■ Creating a Default LandingMatrix on Page 57

■ Editing a Default LandingMatrix Configuration on Page 58

■ Viewing Default LandingMatrix Configurations on Page 58

■ Creating a Default LandingMatrix Template on Page 58

■ Deleting a Default LandingMatrix Configuration on Page 59

Creating a Default Landing Matrix

To Create a Default Landing Matrix

1. Right-click the OTIS Elevator System folder in the Hardware tree and select OTIS Default Landing Matrix>New.



(Alternately, you can select OTIS Default Landing Matrix from the Hardware drop-downmenu, and then click the
New icon.

2. Enter a name for the default landingmatrix in theName field.

3. Enter a description (optional) for the default landingmatrix in theDescription field.

4. Click in the check boxes next to the floors that you want to include in the default landingmatrix. For front door, use the
Front tab. Similarly for the rear door, use the Rear tab.

5. Click Save and Closewhen done.

The default landingmatrix is listed underOTIS Default Landing Matrix in the tree under the OTIS Elevator System
folder.

Editing a Default Landing Matrix Configuration

To Edit a Default Landing Matrix Configuration

1. Click the arrow located to the left of the OTIS Elevator System folder.

2. Click the arrow located to the left of OTIS Default Landing Matrix icon.

3. Right-click the default landingmatrix that you want to edit and select Edit from the context menu.

(Alternately, you can double-click theOTIS Default Landing Matrix icon to open a Dynamic View displaying OTIS
Default LandingMatrix configurations. Then, either double-click the default landingmatrix or right-click the default
landingmatrix that you want to edit to open theOTIS default LandingMatrix dialog box.)

TheOTIS Default LandingMatrix dialog box opens.

4. Make your changes to the configuration.

5. Click Save and Close.

Viewing Default Landing Matrix Configurations

Default LandingMatrix configurations are viewed in the Dynamic View.

To View Default Landing Matrix Configurations

1. Double-click theOTIS Default Landing Matrix icon under the OTIS Elevator System folder.

Default LandingMatrix configurations are displayed in the OTIS Default LandingMatrix tab in the Dynamic View.

Creating a Default Landing Matrix Template

To Create a Default Landing Template

1. Right-click the OTIS Elevator System folder and select OTIS Default Landing Matrix>New Template.

(Alternately, you can right-click theOTIS Default Landing Matrix icon and select New Template.)

2. Enter a name for the template in theName field.

3. Enter a description (optional) in theDescription field.

4. Click in the check boxes next to the floors that you want to include in the default landingmatrix template. For front
door, use the Front tab. Similarly for the rear door, use the Rear tab.



5. Click Save and Closewhen done.

The new template is listed underOTIS Default Landing Matrix>Templates.

Deleting a Default Landing Matrix Configuration

NOTE You cannot delete a Default LandingMatrix if there are DEC configurations associated with
the Default LandingMatrix. Youmust delete the DEC configurations before you can delete
the Default LandingMatrix.

To Delete a Default Landing Matrix Configuration

1. Click the arrow located to the left of the OTIS Elevator System folder.

2. Click the arrow located to the left of theOTIS Default Landing Matrix.

3. Right-click the default landingmatrix that you want to delete and select Delete.

(Alternately, you can right-click a default landingmatrix configuration in the Dynamic View and select Delete.)

The Deleting OTIS Default LandingMatrix objects dialog box opens.

4. Click Yes to confirm the deletion.

The object is deleted.

5. Click OK to confirm that the object was deleted.



5

Chapter 5 - OTIS Landing Configuration

This chapter describes how to configure a landing (floor) using the OTIS Landing dialog box.

In this chapter

Accessing the OTIS Landing Dialog Box 61
OTIS Landing Dialog Box 62
Landing Dialog Box - Override Tab 65
Landing Dialog Box - State Images Tab 66
OTIS LandingManual Actions 68



Accessing the OTIS Landing Dialog Box
TheOTIS Landing dialog box is used to identify a Landing index to be used by the Elevator System.

NOTE TheOTIS Elevator Systemmust be configured before you can access this dialog box. See
OTIS Elevator System Editor Dialog BoxChapter 2, OTIS Elevator System Configuration for
more information.

To Access the OTIS Landing Dialog Box

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree, and select
OTIS Landing>New, as shown in Figure 20 on Page 61.

Figure 20:  Access theOTIS Landing Dialog Box

TheOTIS Landing dialog box, shown in Figure 21 on Page 62, opens.



OTIS Landing Dialog Box
TheOTIS Landing dialog box, shown in Figure 21 on Page 62, lets you create a landing (floor) to be used by the Elevator
System.

For more information, see the following:

■ Accessing the OTIS Landing Dialog Box on Page 61

■ OTIS Landing Dialog Box Definitions on Page 62

■ OTIS Landing Dialog Box Tasks on Page 63

Figure 21:  OTIS Landing Dialog Box

OTIS Landing Dialog Box Definitions

Table 10 on Page 62 describes the OTIS Landing dialog box fields and buttons.

Field/Button Description

Name The Landing Index value you enter appears in the Name field.

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Table 10:  OTISElevator System Landing Dialog BoxDefinitions



Field/Button Description

Description Optional. Enter a description for the landing.

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

General Tab

Elevator System The name of the OTISElevator System. This field is read-only.

Landing Index (Floor
Number)

Landing index is the indexassociated with the Landing. The value is between -127 to 127.

DECMap NOTE: The following read-only information is not available until the DEC Configuration is complete.

• DECID – The unique identifier for the DEC

• DEC Name – The name of the configured DEC.

• Door Name – The name of the assigned door.

Override Status Tab

Override Status Displays the override statusof the floor object. This field is read-only.

The three override statutesare: Secure, Unsecure, and Normal.

Table 10:  OTISElevator System Landing Dialog BoxDefinitions (continued)

OTIS Landing Dialog Box Tasks

This section describes the following tasks:

■ Creating a Landing Configuration on Page 63

■ Editing a Landing Configuration on Page 64

■ Viewing Landing Configurations on Page 64

■ Deleting a Landing Configuration on Page 64

Creating a Landing Configuration

To Create a Landing Configuration

1. Right-click the Elevator System in the tree and select OTIS Landing>New.

2. Enter a name for the landing in theName field.

3. Enter a description (optional) in theDescription field for the Landing Index.

4. Click Save and Close.

5. Go to OTIS DEC Clearance LandingMatrix Dialog Box on Page 74 to configure the clearance for the landing.



Editing a Landing Configuration

To Edit a Landing Configuration

1. Double-click the Landing configuration in the tree that you want to edit.

(Alternately, you can right-click the landing configuration in the tree and select Edit from the context menu.)

2. Make the changes to the configuration.

3. Click Save and Close.

Viewing Landing Configurations

To View Landing Configurations

1. Select OTIS Landing from theHardware drop-downmenu.

2. Click the green right arrow to open a Dynamic View displaying all Landings.

TheOTIS Landing tab opens in the Dynamic View displaying a list of OTIS Landing configurations.

Deleting a Landing Configuration

NOTE You cannot delete a landing if there are DEC configurations associated with the landing. You
must delete the DEC configurations before you can delete the landing.

To Delete a Landing Configuration

1. Right-click the Landing configuration that you want to delete and select Delete from the context menu.

(Alternately, you can select OTIS Landing from theHardware drop-downmenu and click the green right arrow to
open a Dynamic View displaying all Landings.)

The Deleting OTIS Landing objects dialog box opens.

2. Click Yes to confirm the deletion.

The object is deleted.

3. Click OK to confirm that the object was deleted.

OTIS Landing Dialog Box Tabs

The following sections provide information about the OTIS Landing dialog box tabs:

■ Landing Dialog Box - Override Tab on Page 65

■ Landing Dialog Box - State Images Tab on Page 66



Landing Dialog Box - Override Tab
TheOverride tab, shown in Figure 22 on Page 65, provides read-only information about override status of the landing for
whichmanual action is performed. For a landing, the Override Status can be, Secure, Unsecure or Normal.

Figure 22:  Landing Dialog Box - Override Tab



Landing Dialog Box - State Images Tab
The State Images tab , shown in Figure 23 on Page 66 displays the current elevator system images that display in the
Monitoring Station to represent themanual action activities concerning the elevator system. You can select other images
to display for this elevator system and return back to the default images, as described in this section.

State Image Description

Normal

Secure

Unsecure

Table 11:  OTIS Landing Dialog BoxState ImagesTab- Descriptions

For information about manual actions, seeOTIS LandingManual Actions on Page 68.

Figure 23:  Landing Dialog Box - State ImagesTab



State Images Tab Tasks

The following tasks are performed in the State Images tab:

■ Replace a State Image on Page 67

■ Restore the Default State Image on Page 67

Replace a State Image

To Replace an Image

1. Double-click the default image in the tab to open aWindows file selection dialog box.

2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.

The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

To Restore the Default Image

■ Right-click the image in the State Images tab and select Restore Default.



OTIS Landing Manual Actions
A Manual Action is a specific type of action that the operator can perform on objects in the system. Manual Actions are
those actions that open aManual Action dialog box, and the actions are also logged in the Activity Viewer as “Manual
Event by Operator Name,” along with the Name of the action, Name of the Event, Partition, date and time. Completed
Manual actions are logged in the Activity Viewer.

OTIS LandingManual Actions areSecure Landing andUn-secure Landing.

For more information, see the following:

■ Accessing OTIS LandingManual Actions on Page 68

■ UsingManual Actions to Secure a Landing on Page 69

■ UsingManual Actions to Un-Secure a Landing on Page 70

■ CancelingManual Actions on Page 128

For information about configuring OTIS events and actions, seeOTIS Events on Page 122.

Accessing OTIS Landing Manual Actions

NOTE The Landing (OTIS Landing Dialog Box on Page 62) must be configured before you can
secure or un-secure a landing.

To Access the OTIS Landing Manual Actions

1. Click the OTIS Elevator System folder in the Hardware tree.

2. Right-click the OTIS Landing that you want to perform theManual Action.

TheManual Action selections areSecure Landing andUn-Secure Landing as shown in Figure 24 on Page 69.



Figure 24:  Accessing theOTIS LandingManualActions

Using Manual Actions to Secure a Landing

This action secures the Landing. There is no access to the Landing during the date and time value set, except the
personnel in the Exemption Group list.

To Secure a Landing

1. Right-click the Landing configuration that you want to secure and select Secure Landing from the context menu. The
Secure Landing dialog box opens.



Figure 25:  OTIS Secure Landing Dialog Box

2. Enter the time and date to secure the Landing in theStart field, or click to use the calendar controls to set the date.

3. Enter the time and date to un-secure the Landing in theEnd field, or click to use the calendar controls to set the
date.

4. Select thePriority. This field indicates the priority level the system uses for sorting when displaying on the
Monitoring Station and prioritizing actions associated with the event. The default priority is 75, Medium Low. Select a
value from the drop-down list or type an integer from 0 to 200 to assign a priority to the Event. The lowest value is 0;
the highest is 200.

5. Select the Time Zone for the secure and un-secure times.

6. Enter a note for future reference in the Instructions field.

Using Manual Actions to Un-Secure a Landing

This action un-secures the Landing. Everyone will have access to the Landing during the date and time value set.

To Un-Secure a Landing

1. Right-click the Landing configuration that you want to un-secure and select Un-Secure Landing from the context
menu. The Un-Secure Landing dialog box opens.



Figure 26:  OTIS Un-Secure Landing Dialog Box

2. Enter the time and date to un-secure the Landing in theStart field, or click to use the calendar controls to set the
date.

3. Enter the time and date to end the un-secure Landing in theEnd field, or click to use the calendar controls to set
the date.

4. Select thePriority. This field indicates the priority level the system uses for sorting when displaying on the
Monitoring Station and prioritizing actions associated with the event. The default priority is 75, Medium Low. Select a
value from the drop-down list or type an integer from 0 to 200 to assign a priority to the Event. The lowest value is 0;
the highest is 200.

5. Select the Time Zone for the secure and un-secure times.

6. Enter a note for future reference in the Instructions field.

NOTE Whenever themanual action (secure landing/un-secure landing) is triggered and in betweenOTIS
Elevator System integration restarts, the floor normal message is displayed first on theMonitoring station
and thenmanual action (secure landing/un-secure landing) message is displayed.

NOTE Manual Action which is triggered last will be processed irrespective of the Priority set.
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Chapter 6 - OTIS DEC Clearance Landing Matrix Configuration

This chapter describes to configure clearances using the OTIS DEC Clearance LandingMatrix dialog box.

In this chapter

Accessing the OTIS DEC Clearance LandingMatrix Dialog Box 73
OTIS DEC Clearance LandingMatrix Dialog Box 74



Accessing the OTIS DEC Clearance Landing Matrix Dialog Box
This section describes how to access the OTIS DEC Clearance LandingMatrix dialog box.

To Access the Dialog Box

1. Right-click the elevator system icon under the OTIS Elevator System folder and select OTIS Clearance Landing
Matrix>New, as shown in Figure 27 on Page 73.

Figure 27:  Access theOTIS DEC Clearance LandingMatrixDialog Box

TheOTIS Clearance LandingMatrix dialog box, as shown in Figure 28 on Page 74, opens.



OTIS DEC Clearance Landing Matrix Dialog Box
TheOTIS DEC Clearance LandingMatrix dialog box, shown in Figure 28 on Page 74, is used to define up to 127 front and
127 rear doors that can be accessed by cardholders that have a clearance associated with the landingmatrix. For
ICD Version 1.0 the DEC Clearance LandingMatrix dialog box is shown in Figure 29 on Page 75.

For more information, see the following:

■ Accessing the OTIS DEC Clearance LandingMatrix Dialog Box on Page 73

■ OTIS DEC Clearance LandingMatrix Dialog Box Definitions on Page 75

Figure 28:  OTIS DEC Clearance LandingMatrixDialog Box



Figure 29:  OTIS DEC Clearance LandingMatrixDialog Box(For ICD Version 1.0)

OTIS DEC Clearance Landing Matrix Dialog Box Definitions

Table 12 on Page 75 describes the OTIS DEC Clearance LandingMatrix dialog box fields and buttons.

Field/Button Description

Name The name of the DEC Clearance LandingMatrix

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Description Optional. Enter a description for the DEC Clearance LandingMatrix .

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Table 12:  OTISDEC Clearance Landing Dialog BoxDefinitions



Field/Button Description

Save and Close Saves the configuration and closes the dialog box.

General Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Clearance Name The pre-configured personnel clearance. This field is used to select the clearance that allowsaccess to the Door with a
reader that a person swipes their card to get authorization to use the landing.

Note: This is amandatory field. If you try to save the Clearance landingMatrixwithout mapping the Clearance, an
error message displays.

Home Floor Optional. The Home Floor is the default floor in OTIS and should bemapped to a clearance.

You can select the Home Floor from -127 to 127. Youmust select either Front or Rear door.

Note: Front and Rear door selectionsare not applicable for ICD Version v1.0.

Note: ThisHome Floor should be selected in the landingmatrix associated to Clearance LandingMatrix.

LandingMatrix Allowsselection of a pre-configured Default LandingMatrix.

Table 12:  OTISDEC Clearance Landing Dialog BoxDefinitions (continued)

OTIS DEC Clearance Landing Matrix Dialog Box Tasks

This section describes the following tasks:

■ Creating a DEC Clearance LandingMatrix on Page 76

■ Viewing DEC Clearance LandingMatrix Configurations on Page 77

■ Deleting a DEC Clearance LandingMatrix Configuration on Page 78

■ Creating a DEC Clearance LandingMatrix Template on Page 78

Creating a DEC Clearance Landing Matrix

To Create a DEC Clearance Landing Matrix

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select OTIS
DEC Clearance Landing Matrix>New.

2. Enter a name, of up to 100 characters, for the clearance landingmatrix in theName field.

3. Enter a description (optional) of up to 500 characters in theDescription field.

4. Click the selection button located to the right of the Clearance Name field to open the Clearance selection
dialog box.

5. Click a clearance to select it.

6. Optional Click the Landing Matrix tab.

7. Optional Click theAdd button.

8. Optional Click the selection button in the empty row under Landing Matrix to open theOTIS Default Landing
Matrix selection box.



9. Optional Click a default landingmatrix configuration to select it. The selection appears under LandingMatrix.

10. Click Save and Closewhen done.

Creating a DEC Clearance Landing Matrix with Home Floor

To Create a DEC Clearance Landing Matrix with Home Floor

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select OTIS
DEC Clearance Landing Matrix>New.

2. Enter a name, of up to 100 characters, for the clearance landingmatrix in theName field.

3. Enter a description (optional) of up to 500 characters in theDescription field.

4. Click the selection button located to the right of the Clearance Name field to open the Clearance selection
dialog box.

5. Click a clearance to select it.

6. Enter a value, between -127 and 127, to identify Clearance LandingMatrix Home Floor. Youmust select either Front
orRear.

7. Click Save and Closewhen done

Home Floor Configuration

Pre-Requisites:

l Landing for Home Floor should be created

l Default LandingMatrix should be created which should have Home Floor

l Home Floor should be part of created Default LandingMatrix

NOTE 1. In Clearance landingmatrix, add Home Floor.

2. Under LandingMatrix tab, make sure to add Default LandingMatrix that has Home Floor selected.

3. It is recommended to have only 1 Home Floor/Clearance LandingMatrix per person.

Viewing DEC Clearance Landing Matrix Configurations

To View DEC Clearance Landing Matrix Configurations

1. Click theHardware drop-downmenu and select OTIS DEC Clearance Landing Matrix.

2. Click the green right arrow located to the right of theHardware drop-downmenu.

TheOTIS DEC Clearance LandingMatrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
Matrix configurations.

Editing a DEC Clearance Landing Matrix Configuration

To Edit a DEC Clearance Landing Matrix Configuration

1. Click theHardware drop-downmenu and select OTIS DEC Clearance Landing Matrix.



2. Click the green right arrow located to the right of the Hardware drop-downmenu.

TheOTIS DEC Clearance LandingMatrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
configurations.

3. Right-click the OTIS DEC Clearance LandingMatrix that you want to edit and select Edit from the context menu.

Alternately, you can double-click the DEC Clearance LandingMatrix configuration to open theOTIS DEC Clearance
LandingMatrix dialog box.

4. Make the changes to the configuration.

5. Click Save and Close.

Deleting a DEC Clearance Landing Matrix Configuration

To Delete a DEC Clearance Landing Matrix Configuration

1. Click theHardware drop-downmenu and select OTIS DEC Clearance Landing Matrix.

2. Click the green right arrow located to the right of the Hardware drop-downmenu.

TheOTIS DEC Clearance LandingMatrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
configurations.

3. Right-click the OTIS DEC Clearance LandingMatrix configuration that you want to delete and select Delete from the
context menu.

The Deleting OTIS DEC Clearance LandingMatrix objects dialog box opens.

4. Click Yes to confirm the deletion.

The object is deleted.

5. Click OK to confirm that the object was deleted.

Creating a DEC Clearance Landing Matrix Template

To Create a DEC Clearance Landing Matrix Template

1. Right-click the elevator system icon under the OTIS Elevator System folder and select OTIS DEC Clearance
Landing Matrix>New Template.

2. Enter the information for the clearance landingmatrix template.

3. Click Save and Close.

The new template is listed underOTIS DEC Clearance Landing Matrix>Templates.
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Chapter 7 - OTIS DEC Configuration

This chapter describes to configure the DEC (Destination Entry Computer) using the OTIS DEC dialog box.

In this chapter

Accessing the DEC Dialog Box 80
OTIS DEC Dialog Box 81
DEC - LandingMatrix Tab 87
DEC - ScheduleMatrix Tab 89
DEC OperationModes Tab 91
DEC Triggers Tab 93
DEC Status Tab 96
DEC Clearances Tab 98
DEC Card Format Tab 109
DEC iStar Doors Tab 111
DEC State Images Tab 113



Accessing the DEC Dialog Box
This section explains how to access the OTIS DEC dialog box.

NOTE TheOTIS Elevator Systemmust be configured before you can access this dialog box. See
OTIS Elevator System Editor Dialog Box andOTIS Landing Dialog Box on Page 62 for more
information.

To Access the DEC Dialog Box

1. Click the elevator system icon under the OTIS Elevator System folder under the Hardware tree.

2. Right-click the Landing and select OTIS DEC>New, as shown in Figure 30 on Page 80.

Figure 30:  Access the DEC Dialog Box

TheOTIS DEC dialog box , shown inFigure 31 on Page 82 opens.



OTIS DEC Dialog Box
TheOTIS DEC dialog box, shown in Figure 31 on Page 82, represents DEC present in the OTIS Elevator system. The
OTIS DEC dialog box lets you configure the DEC general information, including Door Name, IP address, enable Audit,
enable Pin, assign a pre-configured schedule and set operationmode.
For ICD Version 1.0 the DEC dialog box is shown in Figure 32 on Page 83.

NOTE TheOTIS Elevator System (OTIS Elevator System Editor Dialog Box on Page 26), OTIS
Default LandingMatrix (OTIS Default LandingMatrix Dialog Box on Page 56) and the
OTIS Landing (OTIS Landing Dialog Box on Page 62) must be configured before you can
configure the DEC.

For more information, see the following:

■ Accessing the DEC Dialog Box on Page 80

■ DEC Dialog Box Definitions on Page 83

■ OTIS DEC Dialog Box Tasks on Page 84

■ OTIS DEC Dialog Box Tabs on Page 86



Figure 31:  OTIS DEC Dialog Box (ICD versions2, 2.2, 3, and 3.1)



Figure 32:  OTIS DEC Dialog Box (ICD Version 1.0)

DEC Dialog Box Definitions

Table 13 on Page 83 describes the OTIS DEC dialog box- General tab fields and buttons.

Field/Button Description

Name Aunique name identifying the DEC configuration.

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Table 13:  OTISDEC Dialog Box - General Tab Definitions



Field/Button Description

Description Optional. A description for the DEC configuration.

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

General Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Landing Name The name of the Landing. This field is read-only.

IP Address IP Addressof the DEC. Enter the unique IPAddress.

Enter the value in the fourth subnet. The first three subnet addressesare fixed, and the value range of fourth
subnet address is from 1 to 240. The third subnet address is the same as the DER/DES’s third subnet address.

Enable Audit Enable (checked)indicatesC•CURE9000 will start receiving floor selectionmessages from the respective DEC.
Default: Disabled (unchecked)

NOTE: This check box is not applicable for ICD Version V1.0.

Enable PIN Enable (checked) indicatesPin entry is enabled at the respective DEC.When the Enable PIN checkbox is
selected, the DEC can accept or reject the Pin codes. For more information see, DEC ClearancesTab on Page
98.
Default: Disabled (unchecked)

NOTE: This check box is not applicable for ICD Version V1.0.

Table 13:  OTISDEC Dialog Box - General Tab Definitions (continued)

OTIS DEC Dialog Box Tasks

This section describes the following tasks:

■ Configuring a DEC on Page 84

■ Editing a DEC Configuration on Page 85

■ Viewing All DEC Configurations on Page 86

■ Deleting a DEC Configuration on Page 86

Configuring a DEC

To Configure a DEC

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select
OTIS DEC>New.

TheOTIS DEC dialog box opens.

2. Enter a name, of up to 100 characters, for the DEC in theName field.

3. (Optional) Enter description for the DEC configuration in theDescription field.



4. Enter the IP address for DEC. For each group ID of the Elevator System, DEC address vary from XXX.YYY.n.1 to
XXX.YYY.n.240.

5. (Optional) Select theEnable Audit orEnable PIN check box.

6. (Optional) In the OperationModes section click theEdit button to change theOperationmode for this DEC in the
OTIS System. For more information on selecting the OperationMode seeOperationModeMessage.

7. Click Save and Close to save the configuration.

Selecting the Operation Mode

To Select the Operation Mode

1. In the OperationModes section click theEdit button. A warningmessage appears as shown in the Figure 33.

Figure 33:  OperationModeMessage

2. Click OK. DEC OperationModes window opens to select the OperationMode as shown in Figure 34 on Page 85.

Figure 34:  DEC OperationModes

3. Select the OperationMode and click Submit.

Editing a DEC Configuration

To Edit a DEC Configuration

1. Double-click the DEC configuration in the tree that you want to edit.

Alternately, you can right-click the DEC configuration in the tree and select Edit from the context menu.



2. Make the changes to the configuration.

3. Click Save and Close.

Viewing All DEC Configurations

To View All DEC Configurations

1. Click theHardware drop-downmenu and select OTIS DEC.

2. Click the green right arrow located to the right of theHardware drop-downmenu.

TheOTIS DEC tab opens in the Dynamic View displaying a list of OTIS DEC configurations.

Deleting a DEC Configuration

To Delete a DEC Configuration

1. Right-click the DEC configuration that you want to delete and select Delete from the context menu.

The Deleting OTIS DEC objects dialog box opens.

2. Click Yes to confirm the deletion.

The object is deleted.

3. Click OK to confirm that the object was deleted.

OTIS DEC Dialog Box Tabs

The following sections provide information about the OTIS DEC Dialog Box Tabs:

■ DEC - LandingMatrix Tab on Page 87

■ DEC - ScheduleMatrix Tab on Page 89

■ DEC OperationModes Tab on Page 91

■ DEC Triggers Tab on Page 93

■ DEC Status Tab on Page 96

■ DEC Clearances Tab on Page 98

■ DEC Card Format Tab on Page 109

■ DEC iStar Doors Tab on Page 111

■ DEC State Images Tab on Page 113



DEC - Landing Matrix Tab
TheOTIS DEC dialog box - LandingMatrix tab, shown in Figure 35 on Page 87, is used to assign a pre-configured default
landingmatrix configuration to a DEC.

For more information, see the following:

■ LandingMatrix Tab Definitions on Page 87

■ LandingMatrix Tab Tasks on Page 88

Figure 35:  OTIS DEC Dialog Box - LandingMatrix Tab

Landing Matrix Tab Definitions

Table 14 on Page 87 describes the LandingMatrix tab fields and buttons.
Table 14:  OTISDEC Dialog Box - LandingMatrix Tab Definitions

Field/Button Description

Add Addsan empty row to the table for selection of a default landingmatrix configuration.



Field/Button Description

Remove Removesand deletes the selected default landingmatrix configuration from the table.

LandingMatrix The default landingmatrix configuration selected.

Landing Matrix Tab Tasks

This section includes the following tasks:

■ Configuring anOTIS LandingMatrix on Page 88

■ Deleting anOTIS LandingMatrix on Page 88

Configuring an OTIS Landing Matrix

To Configure an OTIS Landing Matrix

1. Click the Landing Matrix tab.

2. Click theAdd button.

3. Click the selection button in the empty row under Landing Matrix to open theOTIS Default LandingMatrix
selection box.

4. Click a default landingmatrix configuration to select it. The selection appears under LandingMatrix.

5. Click Save and Close.

Deleting an OTIS Landing Matrix

To Delete an OTIS Landing Matrix

1. Click in the row containing the default landingmatrix you want to delete.

2. Click theRemove button.



DEC - Schedule Matrix Tab
TheOTIS DEC dialog box - ScheduleMatrix tab, shown in Figure 36 on Page 89, is used to assign a pre-configured
schedule to a pre-configured default landingmatrix configuration.

For more information, see the following:

■ ScheduleMatrix Tab Definitions on Page 89

■ ScheduleMatrix Tab Tasks on Page 90

Figure 36:  OTIS DEC Dialog Box - ScheduleMatrix Tab

Schedule Matrix Tab Definitions

Table 15 on Page 89 describes the ScheduleMatrix tab fields and buttons.
Table 15:  OTISDEC Dialog Box - ScheduleMatrix Tab Definitions

Field/Button Description

Add Addsan empty row to the table for selection of a default landingmatrix configuration and to select a schedule to assign to it.

Remove Removesand deletes the selected default landingmatrix configuration and the assigned schedule from the table.



Field/Button Description

Landing
Matrix

The default landingmatrix configuration is selected.

Schedule The schedule selected for the default landingmatrix configuration. See the C•CURE9000 Software Configuration Guide for
more information about configuring schedules.

Schedule Matrix Tab Tasks

This section includes the following tasks:

■ Configuring anOTIS Landing ScheduleMatrix on Page 90

■ Deleting anOTIS Landing ScheduleMatrix on Page 90

Configuring an OTIS Landing Schedule Matrix

NOTE Only seven Landing schedulematrices are supported for a DEC.

To Configure an OTIS Landing Schedule Matrix

1. Click theSchedule Matrix tab.

2. Click theAdd button.

3. Click the selection button in the empty row under Landing Matrix to open theOTIS Default LandingMatrix
selection box.

4. Click a default landingmatrix configuration to select it. The selection appears under LandingMatrix.

5. Click in blank field under Schedule, and then click the selection button . The Schedule selection box opens.

6. Click a schedule to select it. The selection appears under Schedule.

7. Click Save and Close.

Deleting an OTIS Landing Schedule Matrix

To Delete an OTIS Landing Schedule Matrix

1. Click in the row containing the default landingmatrix schedule you want to delete.

2. Click theRemove button.



DEC Operation Modes Tab
TheOTIS DEC dialog box - OperationModes tab, shown in Figure 37 on Page 91, is used to set the OperationMode for
the DEC and assign a pre-configured schedule to it.

For more information, see the following:

■ OperationModes Tab Definitions on Page 91

■ OperationModes Tab Tasks on Page 92

Figure 37:  OTIS DEC Dialog Box - OperationModesTab

Operation Modes Tab Definitions

Table 16 on Page 91 describes the Front Reader tab field.
Table 16:  OTISDEC Dialog Box - OperationModesTab Definitions

Field Description

Add Addsan empty row to the table to select the OperationModesand schedule to assign to it.

Remove Removesand deletes the selectedOperationMode and the assigned schedule from the table.



Field Description

Operation
Modes

Select the OperationMode for which thisDEC is configured.User Entry of Destination Floor is the default value. You can
choose one of the following:

• Default Floor Only

• Access to Authorized Floors

• User Entry of Destination Floor

• Default Floor or User Entry of Destination Floor

Schedule The schedule selected for the OperationModes. See the C•CURE9000 Software Configuration Guide for more information
about configuring schedules.

Operation Modes Tab Tasks

This section includes the following tasks:

■ Selecting anOperationMode for the DEC on Page 92

■ Deleting anOperationMode for the DEC on Page 92

Selecting an Operation Mode for the DEC

To Select an Operation Mode for the DEC

1. Click theOperation Modes tab.

2. Click theAdd button.

3. Click the drop-down in the empty row underOperation Modes to list the OperationModes.

4. Click the OperationMode select it. The selection appears under OperationModes.

5. Click in blank field under Schedule, and then click the selection button . The Schedule selection box opens.

6. Click a schedule to select it. The selection appears under Schedule.

7. Click Save and Close

Deleting an Operation Mode for the DEC

To Delete an Operation Mode for the DEC

1. Click in the row containing the default landingmatrix schedule you want to delete.

2. Click theRemove button.



DEC Triggers Tab
TheOTIS DEC dialog box - Triggers tab, shown in Figure 38 on Page 93, is used to configure DEC related triggers to
activate events.

For more information, see the following:

■ DEC Triggers Tab on Page 93

■ Triggers Tab Tasks on Page 94

Figure 38:  OTIS DEC Dialog Box - TriggersTab



Triggers Tab Definitions

TheOTIS DEC dialog box – Triggers tab fields and buttons are described in Table 17 on Page 94

Field/Button Description

Add Click this button to create a new row in the Triggers table. Youmust configure all fields in the row to complete the Add operation.

Remove Click this button to remove a selected row from the Triggers table.

Property
Click in the Property field to display the selection button , and then click to select CommunicationStatusproperty
(the only selection available).

Value Selectionsare Online andOffline.

Action Click the drop-downmenu to select an action to occur. This action selected will occur when the object's selected Property
receives the selected Value.

Details The name of the event configured for the row (read-only) entered by the system.

Event
Click the selection button to select a Event that you want to associate with the trigger. Events are created in the C•CURE
9000 Configuration pane. See theC•CURE9000 Software Configuration Guide for more information.

Table 17:  OTISDEC Dialog Box–TriggersTab Definitions

Triggers Tab Tasks

The following tasks are performed in the Triggers tab:

l Selecting Triggers to Activate Events on Page 94

l Deleting Triggers and Events on Page 95

Selecting Triggers to Activate Events

To Select Triggers to Activate Events

1. Click the Triggers tab.

2. Click theAdd button.

3. Click in the blank row underProperty, and then click the selection button to open theOTIS DEC Property
dialog box.

4. Click CommunicationStatus to select it.

5. Click in the blank field underValue.

6. Click the drop-downmenu and select Offline orOnline.

7. Click the drop-downmenu underAction and select Activate Event.

The Event field appears at the bottom of the dialog box.

8. Click the selection button .

9. Click a pre-configured event to activate.



10. Click Save and Close.

Deleting Triggers and Events

To Delete a Trigger and Event from the Elevator Group

1. Click the row selector button to select the row.

2. Click theRemove button.



DEC Status Tab
TheOTIS DEC dialog box- Status tab, shown in Figure 39 on Page 96, provides read-only information about the
operational status of OTIS DEC.

Supported values are:

■ Online

■ Offline

■ Unknown

Formore information, see the following:

■ Status Tab Descriptions on Page 96

Figure 39:  OTIS DEC Dialog Box– StatusTab

Status Tab Descriptions

TheOTIS Elevator System Editor–Status tab fields are described in Table 18 on Page 97.



Field/Button Description

Communication Status Value (Status):

• Online: TheOTISDEC is configured and communicating with the OTIS server .

• Offline: TheOTIS DEC is configured, but not communicating with the OTIS server.

• Unknown: The status cannot be determined, usually displayed after the initialOTISDEC
configuration while waiting for the OTIS server to update the status .

Table 18:  StatusTab Definitions



DEC Clearances Tab
In the Clearances support, the user will input the clearances for a DEC device. With the valid clearance at DEC, the
personnel has access to authorized floors.

TheOTIS DEC dialog box - Clearances tab, shown in Figure 40 on Page 99, is used tomapDEC's pre-configured
Clearances to the Schedules.

NOTE ■ The configured clearances and schedules in the PIN Code Clearance tab are operational only when
theEnable PIN check box in the DEC General tab is selected. For more information see, DEC Dialog
Box Definitions on Page 83.

■ Only PINs configured on the Credential tab of Personnel are supported.

■ DEC-> Clearance tab is used to allow or deny access to Personnel. After it is derived, the Landing
access is derived based on Clearance LandingMatrix. All clearances need not be part of the DEC->
Clearance tab while deriving the landing access.

For more information, see the following:

■ Clearances Tab Definitions on Page 99

■ Clearance Tab Tasks on Page 100



Figure 40:  OTIS DEC Dialog Box - ClearancesTab

Clearances Tab Definitions

Table 19 on Page 99 describes the LandingMatrix tab fields and buttons.
Table 19:  OTISDEC Dialog Box - LandingMatrix Tab Definitions

Field/Button Description

Add Addsan empty row to the table for selection of a Clearance and Schedule

Remove Removesand deletes the selected Clearance and Schedule from the table.



Field/Button Description

Clearance The pre-configured personnel clearance. See theC•CURE9000 Software Configuration Guide for more information about
configuring clearances.

Schedule The schedule selected for the Clearance. See the C•CURE9000 Software Configuration Guide for more information about
configuring schedules.

Clearance Tab Tasks

This section includes the following tasks:

■ Swiping Card or Entering Pin at Inbuilt Reader of DEC to Grant or Deny Access on Page 100

■ Deriving Clearance LandingMatrix and Sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the Inbuilt Reader of DEC on Page 101

■ Deriving Clearance LandingMatrix and Sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the External Reader of DEC on Page 102

■ Deriving Clearance LandingMatrix and sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the External Reader of DEC havingmultiple iStar doors under iStar Doors tab: on Page 103

■ Configuring a Clearance on Page 107

■ Deleting a Clearance on Page 108

Swiping Card or Entering Pin at Inbuilt Reader of DEC to Grant or Deny Access

Follow the below workflow of card swipe at inbuilt reader of DEC to grant or deny access:

NOTE This workflow is not applicable when DEC is configured with iSTAR door.

Do not configure Clearance - ScheduleMapping when iSTAR door is used for card reads.

1. Swipe the card at inbuilt reader of DEC.

2. Hex value (Card data or Pin data) received from DEC is validated against Card Formats configured under Card
Format tab, refer to DEC Card Format Tab on Page 109.

3. CHUID (Card holder Unique Identifier) is derived and Personnel is identified based on thematched card format.

4. Use the Clearance configured under Clearance tab of DEC tomatch if any of the Clearance configured is assigned to
Personnel or not.

5. If one of the Clearancematches with Clearances configured in Personnel under Clearance tab, then the user is
granted with the access.

NOTE Clearance configured under Clearance tab of DEC with Active schedule is used to grant access.

Clearance with Inactive schedule cannot grant access.



Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the Inbuilt Reader of DEC

After access is granted, follow the below workflow to derive the Clearance LandingMatrix and send the list of floors

to DEC:

Refer Table 20 on Page 101 for the configuration or mapping of Clearances.
Table 20:  Configuration of Clearances

SL.No DEC (or)
Personnel Clearances Schedule

Status Notes

1 DEC 1 Clearance 1 Active Clearances-Schedulemapping under Clearances tab of DEC

DEC 1 Clearance 2 Inactive

2 Personnel1 Clearance 1

Clearance 2

Clearance 3

Clearance 4

Clearancesaremapped under Clearance tab of Personnel record in
C•CURE9000

Refer Table 21 on Page 101 for the configuration of Elevator Systems.
Table 21:  Configuration of Elevator Systems

SL.No Elevator Systems Clearances Clearance Landing Matrix (CLM) Floors

1 Elevator System1 Clearance 1 Clearance LandingMatrix 1 1, 2, and 3

Elevator System1 Clearance 2 Clearance LandingMatrix 2 4, 5, and 6

Elevator System1 Clearance 3 Clearance LandingMatrix 3 7, 8, and 9

Note: Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.

Workflow:

1. WhenPersonnel1 swipes a card at DEC1 associated withElevator System1, then the Clearance associated under
Clearances tab of DEC is used to grant access to Personnel.

• In this caseClearance 1 is used to grant access. Clearance 2 cannot grant access, as it has Inactive schedule.

2. After the access is granted, OTIS integration derives the list of all Clearances associated with Personnel.

• In this case the list includes Clearance 1, Clearance 2, Clearance 3, andClearance 4.

3. OTIS integration will now derive the list of associated Clearancemapped withActive schedules under Clearance tab
of DEC.

4. OTIS integration performs the comparison of results derived in Steps 2 and 3, and list of Clearances with Active
schedule are shortlisted.

• In this case, only Clearance 1will be derived as it is mapped to Active schedule andClearance 2will be ignored
as it is mapped to Inactive schedule.



5. Any additional Clearances associated with Personnel andmapped with Clearance LandingMatrix will also be
considered for Clearance LandingMatrix calculation.

• In this case, Clearance 3will be considered andClearance 4will be ignored as it does not have any Clearance
LandingMatrix configured in system associated with Personnel.

6. OTIS integration derives the list of associated Clearance LandingMatrices with the above Clearances.

• In this case, following two LandingMatrices are derived:

— Clearance LandingMatrix 1

— Clearance LandingMatrix 3

• Clearance Landing Matrix 2will not be considered as schedule associated with Clearance2 is Inactive. Also
Clearance 4will be ignored as it does not have any Clearance LandingMatrix associated with it.

• CLMs associated with Clearances with Active schedule configured under DEC and Personnel aremerged
together.

— In this case Clearance LandingMatrix 1 and 3 are themerged CLMs.

— As a result, floors associated with Clearance LandingMatrices 1 and 3 are dispatched to DEC.

• In this case floors 1, 2, 3, 7, 8, 9 are dispatched to DEC.

Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the External Reader of DEC

NOTE This workflow is applicable only when DEC is configured with iSTAR readers (Doors).

Use Case: Swiping the card or entering the pin at external reader associated with DEC to Grant or Deny Access
and calculate the Clearance Landing Matrix.

After the access is granted, the OTIS integration follows the below workflow to derive the Clearance LandingMatrix and
send the list of authorized floors to DEC:

Refer Table 22 on Page 102 for the configuration or mapping of Clearances.
Table 22:  Configuration of Clearances

SL.No DEC (or) Personnel Clearances Notes

1 DEC 1 Clearances-Schedulemapping under Clearances tab of DEC

2 Personnel1 Clearance 1

Clearance 2

Clearance 3

Clearance 4

Clearancesaremapped under Clearance tab of Personnel record in C•CURE9000

Refer Table 23 on Page 103 for the configuration of Elevator Systems and Clearance LandingMatrix.



Table 23:  Configuration of Elevator Systemsand Clearance LandingMatrix.

SL.No Elevator Systems Clearances Clearance Landing Matrix (CLM) Floors

1 Elevator System1 Clearance 1 Clearance LandingMatrix 1 1, 2, and 3

Elevator System1 Clearance 2 Clearance LandingMatrix 2 4, 5, and 6

Elevator System1 Clearance 3 Clearance LandingMatrix 3 7, 8, and 9

Note:Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.

Workflow:

1. After the access is granted (in this case by iSTAR reader), the OTIS integration derives the list of all Clearances
associated with Personnel.

• In this case the list includes Clearance 1, Clearance 2, Clearance 3, andClearance 4.

2. TheOTIS integration derives the list of associated Clearance LandingMatrices with the above Clearances.

• In this case, following three LandingMatrices are derived:

— Clearance LandingMatrix 1

— Clearance LandingMatrix 2

— Clearance LandingMatrix 3

• Clearance 4will be ignored as it does not have any Clearance LandingMatrix associated with it.

3. Clearance LandingMatrix 1, 2 and 3 will bemerged together. As a result, the floors associated with Clearance
LandingMatrices 1, 2 and 3 are dispatched to DEC.

• In this case floors 1, 2, 3,4, 5, 6, 7, 8, and 9 are dispatched to DEC.

NOTE Swiping the valid card at iSTAR reader and clearances with inactive Schedule-Door mapping (refer to
C•CURE 9000 Personnel Configuration Guide-Clearance) are also considered while deriving the
Clearance LandingMatrix.

NOTE Attention- If user associates iSTAR door with DEC and also captures Card Format and Schedule-
Clearancemapping on Card Format tab (refer to Figure 43 on Page 109) and Clearances tab (refer to
Figure 40 on Page 99) respectively, then the list of Authorized floors generated (merged CLMs)may differ
in case of card swipe at iSTAR reader (Door) mapped with DEC. It may also result in Denying of access,
even though personnel have valid clearance to get Access Granted at iSTAR door. This is because,
Schedules associated with the clearances under Clearances tab of DEC are not active. Schedule-
Clearancemapping done under Clearances tab of DEC takes precedence while authorizing Personnel.

Deriving Clearance Landing Matrix and sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the External Reader of DEC having multiple iStar doors under iStar
Doors tab:

NOTE This workflow is applicable only when DEC is configured with iStar readers (Doors).



Use Case: Swiping the card or entering the pin at external reader associated with DEC to Grant or Deny Access
and calculate the Clearance Landing Matrix.

Refer Table 24 on Page 104 for the configuration or mapping of Objects and Clearances.

Sl.No Objects Clearances/Doors Notes

1 DEC 1 None Clearances-Schedule mapping under Clearances tab of DEC

DEC 1 iStar Door 1
iStar Door 2

iStar Doors configured under iStar Doors tab of DEC

2 Personnel1 Clearance 1
Clearance 2
Clearance 3
Clearance 4

Clearances are mapped under Clearances tab of Personnel record in
C•CURE 9000

3 iStar Door 1 Clearance 1 iStar Door mapped to Clearances

4 iStar Door 2 Clearance 2 iStar Door mapped to Clearances

Table 24:  Objects and ClearancesConfigurations

Refer Table 25 on Page 104 for the configuration or mapping of ES and Clearances.

SL.No Elevator
Systems Clearances Clearance Landing

Matrix (CLM)
Clearance Landing Matrix
(CLM) floors

1 Elevator System1 Clearance 1 CLM 1 1, 2 and 3

Elevator
System1

Clearance 2 CLM 2 4, 5 and 6

Elevator
System1

Clearance 3 CLM 3 7, 8 and 9

Note: Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.

Table 25:  ESandClearancesConfigurations

Workflow:

1. When Personnel 1 swipes the card at iStar Door 1, then the access is granted as iStar Door 1 is configured under
iStar Doors tab of DEC 1. Similarly, when Personnel 1 swipes the card at iStar Door 2, then also the access is
granted.

2. After the access is granted, the OTIS integration derives the list of all Clearances associated with Personnel.

l In this case, the lists includes Clearance 1, Clearance 2, Clearance 3, and Clearance 4.

3. TheOTIS integration derives the list of associated Clearance LandingMatrices with the above Clearances.

l In this case, following three LandingMatrices are derived:

l Clearance LandingMatrix 1

l Clearance LandingMatrix 2



l Clearance LandingMatrix 3

l Clearance 4 will be ignored as it does not have any Clearance LandingMatrix associated with it.

4. Clearance LandingMatrix 1, 2 and 3 will bemerged. As a result, the floors associated with Clearance Landing
Matrices 1, 2 and 3 are dispatched to DEC.

l In this case floors 1, 2, 3,4, 5, 6, 7, 8, and 9 are dispatched to DEC.

Home Floor workflow with multiple Clearances for a person:

Scenario 1:Multiple Clearance LandingMatrices (CLMs) with different non-zero Home Floors associated, and if
Personnel associated with the sameClearances mapped to different CLMs and swipe at DEC then following are the
states:

l Scenario A: Home Floor mapped to the Clearance LandingMatrix with Clearance that is assigned at last to the
Personnel is dispatched.

l Scenario B: If the driver restarts, then the Home Floor with maximum ClearanceID will be dispatched.

Example: Whenmultiple Clearance LandingMatrices (such as CLM 1, CLM 2 and CLM 3) with different non-zero Home
Floors are associated, refer Figure 41 on Page 105, and Personnel with sameClearances refer Figure 42 on Page 106

CLM 1with Home Floor as 4, CLM 2with Home Floor as 3 and CLM 3with Home Floor as 10 and Personnel1 with
Clearances as Clearance1, Clearance2 and Clearance3.

l With reference to Scenario A, Home Floor 10 will be dispatched.

l With reference to Scenario B, Home Floor dispatch depends on the ClearanceID.

Figure 41:  Multiple CLMs - Non Zero Home Floors



Figure 42:  Personnelwith sameClearances

Scenario 2:Multiple Clearance LandingMatrices with one non-zero Home Floor associated with one CLM and the
remaining have a default value as zero for Home Floor and if Personnel associated with sameClearances associated with
different CLMs swipe at DEC, then the non-zero Home Floor will be dispatched.

Example: When a person has multiple Clearances (such as Clearance 1, Clearance 2 and Clearance 3) refer Figure 42 on
Page 106

a. Clearance 1 associated with CLM1, with the Home Floor set as 5 and respective Default LandingMatrices (DLM)
should be added to the LandingMatrix. Refer below figure:

b. Clearance 2 associated with CLM2, with the home Floor set as 0, and the Default LandingMatrices should not be
added to the LandingMatrix. Refer below figure:



c. Clearance 3 associated with CLM3, with the home Floor set as 0, and the Default LandingMatrices should not be
added to the LandingMatrix.

Then, when a person swipes a card at DEC1which is associated with Clearance 1, the non-zero Home Floor (5 in this
case, which is associated with CLM1) should be dispatched correctly.

The system behavior should be the same even after the Otis driver service is restarted.

Configuring a Clearance

To Configure a Clearance

1. Click theClearances tab.

2. Click theAdd button.

3. Click the selection button in the empty row underClearance to open the Clearance selection box.

4. Click a Clearance to select it. The selection appears under Clearance.

5. Click in blank field under Schedule, and then click the selection button . The Schedule selection box opens.

6. Click a schedule to select it. The selection appears under Schedule.

7. Click Save and Close.

NOTE User can add only one row combination of a Clearance and Schedule.

NOTE For personnel configured with multiple clearances, it is recommended to add all the clearancesassigned to personnelwith
appropriate schedule. Configuration of common clearance with Always schedule is not recommended. Thiswill result in getting all
personnel access to DOP24*7.



Deleting a Clearance

To Delete a Clearance

1. Click in the row containing the Clearance you want to delete.

2. Click theRemove button.



DEC Card Format Tab
You can associate the pre-configured card format with the DEC using theOTIS DEC-Card Format tab.

Once youmap the card format with the DEC, only the associated card formats will be considered for credential evaluation
on any card swipe done on this DEC.

NOTE You can map only the pre-configured card formats with DEC using OTIS DEC-Card Format tab. You can create
new card formats using the Card Format Editor. For more information, see Card Format Editor in C•CURE 9000
User Manual. CHUID length supported by OTIS integration is 80.

Formore information, see the following:

■ Card Format Tab Definitions on Page 109

■ Card Format Tab Tasks on Page 109

Figure 43:  Figure 41: OTISDEC -Card Format Tab

Card Format Tab Definitions

Table 20 on Page 121 describes the Card Format tab fields and buttons.

Field/Button Description

Add Click this button tomap a card format with the DEC.

Remove Click this button to remove the associated card format from the DEC.

Name The name of the card format that you want to associate with the DEC.

Description Description about the selected card format.

Card Format Tab Tasks

This section includes the following tasks:



■ Mapping a Card Format with the DEC on Page 110

■ Deleting a Card Format on Page 110

Mapping a Card Format with the DEC

To Map a Card Format

Before you Begin

Ensure that all the required card formats are configured in the C•CURE 9000 Card Format Editor.

1. Click theCard Format tab.

2. Click Add.

3. Click in the empty row underName to open the selection box.

4. Click a card format to select. The selection appears in the table with the name and description.

5. Click Save and Close.

Deleting a Card Format

To Delete a Card Format

1. Select the card fromat that you want to delete.

2. Click Remove.



DEC iStar Doors Tab
TheOTIS DEC - iStar Doors tab, shown in Figure 44 on Page 111, is used to assign a pre-configured iStar door to a DEC.

NOTE Single iStar Door configuration option from General tab is removed as iStar Doors tab is added to support multiple
iStar doors under DEC.

Formore information, see the following:

■ iStar Doors Tab Definitions on Page 111

■ iStar Doors Tab Tasks on Page 112

Figure 44:  OTISDEC - iStar DoorsTab

iStar Doors Tab Definitions

Table 20 on Page 121 describes the iStar Doors tab fields and buttons.



Field/Button Description

Add Click this button tomap a iStar Door with the DEC.

Remove Click this button to remove the associated iStar Door from the DEC.

Name The name of the iStar Door that you want to associate with the DEC.

iStar Doors Tab Tasks

This section includes the following tasks:

■ Mapping a iStar Door with the DEC on Page 112

■ Deleting a iStar Door on Page 112

Mapping a iStar Door with the DEC

To Map a iStar Door

Before you Begin

Ensure that all the required iStar Doors are configured in the C•CURE 9000 iStar Door Editor.

1. Click the iStar Doors tab.

2. Click Add.

3. Click in the empty row underName to open the selection box.

4. Click a iStar Door to select. The selection appears in the table with the name and description.

5. Click Save and Close.

Deleting a iStar Door

To Delete a iStar Door

1. Select the iStar Door that you want to delete.

2. Click Remove.

3. Click Save and Close.



DEC State Images Tab
The State Images tab, shown in Figure 45 on Page 113 displays the current DEC images that display in theMonitoring
Station to represent the activities concerning the DEC. You can select other images to display for this DEC and return
back to the default images, as described in this section.

See State Images Tab Tasks on Page 67 for information about changing the state images.

Figure 45:  OTIS DEC Dialog Box– State ImagesTab

State Images Tab Tasks

The following tasks are performed in the State Images tab:

■ Replace a State Image on Page 113

■ Restore the Default State Image on Page 114

Replace a State Image

To Replace an Image

1. Double-click the default image in the tab to open aWindows file selection dialog box.



2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.

The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

To Restore the Default Image

■ Right-click the image in the State Images tab and select Restore Default.
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Chapter 8 - OTIS User Types

This chapter describes how to associate personnel to a User Type. The User Type represents information pertaining to the
credential holder.

In this chapter

Accessing the User Type Dialog Box 116
OTIS User Type Dialog Box 117



Accessing the User Type Dialog Box
This section explains how to access the OTIS User Type dialog box.

NOTE TheOTIS Elevator System (OTIS Elevator System Editor Dialog Box on Page 26), OTIS Default
LandingMatrix (OTIS Default LandingMatrix Dialog Box on Page 56) OTIS Landing (OTIS Landing
Dialog Box on Page 62) and Clearance LandingMatrix must be configured before you can configure
the User Type.

To Access the User Type Dialog Box

1. Click the elevator system icon under the OTIS Elevator System folder under the Hardware tree and select
OTIS User Type>New, as shown in Figure 46 on Page 116.

Figure 46:  Access the User Type Dialog Box

TheOTIS User Type dialog box, shown in Figure 47 on Page 117 opens.



OTIS User Type Dialog Box
TheOTIS User Type dialog box, shown in Figure 47 on Page 117, is used to associate personnel group to a User type.
OTIS allows a user to have combination of User Type. The different User Type are Standard, TD04, TD08, TD10, TD20,
TD40, and TD80. Type Descriptor (TD) defines information pertaining to the credential holder. For example, standard,
person with disability, VIP, vertigo susceptible.

NOTE Standard and ADA user cannot not be combined.

NOTE Per Elevator System, only one object can be created for User Type.

For more information, see the following:

■ Accessing the User Type Dialog Box on Page 116

■ User Type Dialog Box Definitions on Page 117

■ User Type Dialog Box Tasks on Page 118

Figure 47:  OTIS User Type Dialog Box

User Type Dialog Box Definitions

Table 26 on Page 118 describes the OTIS User Type dialog box- General tab fields and buttons.



Field/Button Description

Name Aunique name identifying the User Type configuration.

• The name is not case-sensitive

• Minimum number of characters: 1

• Maximum number of characters: 100

Description Optional. A description for the User Type configuration.

• The description is not case-sensitive.

• Minimum number of characters: None

• Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

User Type Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Add Click this button to create a new row in the User Type table. Youmust configure all fields in the row to
complete the Add operation.

Remove Click this button to remove a selected row from the User Type table.

PersonnelGroup Click the selection button to select the pre-configured personnel group. See the C•CURE9000 Software
Configuration Guide for information on creating personnel groups.

Standard Standard- Indicates standard passenger type. Standard is the default TD.

TD04 Represents that the PersonnelGroup hasVery Important Person (VIP)status. a Enable to designate this
person asa Very Important Person (VIP for OtisCompasspassenger allocation

TD08 Represents that the PersonnelGroup is susceptible to Vertigo or similar conditions.

TD10 Represents that PersonnelGroup is eligible for Split GroupOperation (SGO).

TD20 Represents that the PersonnelGroup is susceptible to Vertigo 2 or similar conditions.

TD40 Represents that the PersonnelGroup is applicable for Cart Svc.

TD80 Represents that the PersonnelGroup is designated to CIMOverride.

Table 26:  OTISUser Type Dialog Box - General Tab Definitions

NOTE For Americans with Disabilities (ADA) status configuration refer to theC•CURE 9000 Personnel
Configuration Guide.

User Type Dialog Box Tasks

This section describes the following tasks:

■ Configuring a User Type on Page 119

■ Editing a User Type Configuration on Page 119



■ Viewing All User Type Configurations on Page 119

■ Deleting a User Type Configuration on Page 119

Configuring a User Type

To Configure a User Type

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select
OTIS User Type>New.

TheOTIS User Type dialog box opens.

2. Enter a name, of up to 100 characters, for the User Type in theName field.

3. In theUser Type tab, click theAdd button.

4. Click in the blank row underPersonnel Group, and then click the selection button to select the Personnel
Group.

5. Select the Personnel Group from the list.

6. Click in the check box to select the User Type for the Personnel Group.

7. Click Save and Close to save the configuration.

Editing a User Type Configuration

To Edit a User Type Configuration

1. Double-click the User Type configuration in the tree that you want to edit.

Alternately, you can right-click the User Type configuration in the tree and select Edit from the context menu.

2. Make the changes to the configuration.

3. Click Save and Close.

Viewing All User Type Configurations

To View All User Type Configurations

1. Click theHardware drop-downmenu and select OTIS User Type.

2. Click the green right arrow located to the right of theHardware drop-downmenu.

TheOTIS User Type tab opens in the Dynamic View displaying a list of OTIS User Type configurations.

Deleting a User Type Configuration

To Delete a User Type Configuration

1. Right-click the User Type configuration that you want to delete and select Delete from the context menu.

The Deleting OTIS User Type objects dialog box opens.

2. Click Yes to confirm the deletion.



The object is deleted.

3. Click OK to confirm that the object was deleted.
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Chapter 9 - OTIS Events and Actions

This chapter describes the C•CURE 9000 events which triggers OTIS Actions and the steps to configure them.

In this chapter

OTIS Events 122
OTIS Actions and Target Objects 123
Configuring C•CURE Events for OTIS Actions 124



OTIS Events
An event is a software definition that you can create using C•CURE 9000 dialog boxes and options. Anything that
C•CURE 9000 canmonitor can be used to generate an event, and the event can trigger any action. You can link an event
directly to a single action or you can link it to multiple events and actions. In the C•CURE 9000OTIS Elevator Integration
you can use an event to trigger event actions.

For more information, see the following:

■ OTIS Actions and Target Objects on Page 123

■ Configuring C•CURE Events for OTIS Actions on Page 124



OTIS Actions and Target Objects
An action is a series of tasks, or a single task, that's executed when an event occurs. The target object is an object on
which the action is to be taken when an event occurs.

Table 27 on Page 123 describes the OTIS action and target objects.

Action Target Object Description

Secure Landing OTIS Landing Select a Landing that you want to secure. This action inhibits the doors
associated with the Landing.When a landing is secured, only people in
an exemption (personnel) Group could access the landing.

Un-secure Landing OTIS Landing Select a Landing to you want to unsecure.When a landing is
unsecured, anybody can access it.

Table 27:  OTISAction and Target Objects



Configuring C•CURE Events for OTIS Actions
The twoOTIS event actions, Secure Landing and Un-secure Landing, are time-based events. You create amanual action
and then schedule the time to secure or un-secure a landing.

This section describes the following tasks:

■ Configuring the Secure Landing Event on Page 124

■ Configuring the Un-secure Landing Event on Page 125

Configuring the Secure Landing Event

To Configure the Secure Landing Event

1. In the Navigation pane of the AdministrationWorkstation, click Configuration to open the Configuration Pane.

2. Select Event from the Configuration drop-down list.

3. Click New to create a new Event. The Event Editor opens.

4. Enter a name for this Event in theName field.

5. Enter a description for this Event in theDescription field.

6. Click Enabled to make the Event available to C•CURE 9000 operators.

7. Click theActions tab to define the action that you want to set for the Event.

8. Click Add.

9. Click in theAction column to display a drop-down list of valid actions.

10. Select Secure Landing.

When you select Secure Landing option, the OTIS Landing entry field appears at the bottom of the dialog box.

11. Click the selection button to select a pre-configured OTIS Landing.

12. (Optional) Click in theResettable check box if you want to allow an operator responding to the Event to reset the
action without acknowledging the Event. This allows Monitoring Station personnel to manually reset the action
caused by the event. Reset actions do not require even acknowledgment.

13. Click theGeneral tab.

14. In theDefault State section, click Armed to arm the event as the default state.

15. In thePriority section, select a value from the drop-down to set the priority level the system uses for sorting when
displaying on theMonitoring Station and prioritizing actions associated with the event.

16. In theScheduling section, click theActivate on Schedule selection button to open a selection box listing
schedules.

17. Click a schedule to select it.

18. Click Save and Close to save the configuration.



Configuring the Un-secure Landing Event

To Configure the Un-secure Landing Event

1. In the Navigation pane of the AdministrationWorkstation, click Configuration to open the Configuration Pane.

2. Select Event from the Configuration drop-down list.

3. Click New to create a new Event. The Event Editor opens.

4. Enter a name for this Event in theName field.

5. Enter a description for this Event in theDescription field.

6. Click Enabled to make the Event available to C•CURE 9000 operators.

7. Click theActions tab to define the action that you want to set for the Event.

8. Click Add.

9. Click in theAction column to display a drop-down list of valid actions.

10. Select Un-secure Landing.

When you select the Un-secure Landing option, the OTIS Landing entry field appears at the bottom of the dialog box.

11. Click the selection button to select a pre-configured OTIS Landing.

12. (Optional) Click in theResettable check box if you want to allow an operator responding to the Event to reset the
action without acknowledging the Event. This allows Monitoring Station personnel to manually reset the action
caused by the event. Reset actions do not require even acknowledgment.

13. Click theGeneral tab.

14. In theDefault State section, click Armed to arm the event as the default state.

15. In thePriority section, select a value from the drop-down to set the priority level the system uses for sorting when
displaying on theMonitoring Station and prioritizing actions associated with the event.

16. In theScheduling section, click theActivate on Schedule selection button to open a selection box listing
schedules.

17. Click a schedule to select it.

18. Click Save and Close to save the configuration.
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Chapter 10 - Monitoring OTIS Elevator Activity

This chapter describes the C•CURE 9000Monitoring Station Activity Viewer and also provides the procedure to cancel OTIS
manual actions.

In this chapter

C•CURE 9000Monitoring Station Activity Viewer 127
CancelingManual Actions 128



C•CURE 9000 Monitoring Station Activity Viewer
The C•CURE 9000Monitoring Station Activity Viewer, shown in Figure 48 on Page 127, displays the OTIS access
control activities.

Activities in the list are displayed in rows that contain an icon, the date and time of the activity, the type of activity or
object, its name, the object’s partition name [in brackets], and an activity message. You can click the activity icon to view
additional information about the object, or right-click the icon to display the context menu for more options or to initiate a
manual action.

NOTE There is no journalling for Floor selection if the ICD version is 1.0.

See theC•CURE 9000Monitoring Station Guide for more information about the Activity Viewer.

Figure 48:  Monitoring Station ActivityViewer



Canceling Manual Actions
This section describes how to cancel the Secure Landing and Un-Secure Landingmanual actions in theMonitoring
Station.

To Cancel a Manual Action in the Activity Viewer

1. Go to theMonitoring Station Activity Viewer, as shown in Figure 49 on Page 128.

Figure 49:  Monitoring Station ActivityViewer

A list of all activities since theMonitoring Station was opened are displayed.

2. Under theExplorer Bar click Non-Hardware Status.

3. UnderNon-Hardware Status click Manual Actions.

The Status List - Manual Action dialog box opens displaying a list of manual actions and their current status.

4. Right-click themanual action in the dialog box that you want to cancel and select Cancel from the drop-downmenu,
as shown in on Page 128.

Figure 50:  Canceling theManualAction



A new entry appears in the Activity Viewer to indicate that themanual action was canceled.
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Chapter 11 - Journal and Audit Messages

This chapter discusses the Journal and the Audit messages and how to locate them.

In this chapter

Journal and Audit LogMessages 131
Locating OTIS Objects in the Journal 133
Locating OTIS Audit Log Entries 134



Journal and Audit Log Messages
Table 28 on Page 131 lists the journal messages reported by the OTIS Elevator System to the C•CURE 9000 database.

All configuration changes to the OTIS Elevator System objects are recorded to the Audit Log.
Table 28:  Journal LogMessages

Category Object State Changes Message Description

Object Change State

Elevator System Online <name of the Elevator System>isOnline

Offline <name of the Elevator System> isOffline

DEC Online <name of the DEC>isOnline

Offline <name of the DEC>isOffline

SystemActivity Driver Start SystemActivity: OTISElevator Driver Service started on
computer <computer name>

Stop SystemActivity: OTISElevator Driver Service stopped on
computer <computer name>

ManualActions Landing Secure Manual action by<Operator Name> lock<OTISCCUREFloor
<Landing Name>from <Date Start time> to <Date End Time>

Unsecure Manual action by<Operator Name>unlock<OTISCCUREFloor
<Landing Name>from <Date Start time> to <Date End Time>

Floor Selection Landing NA <Personnel Name> selected <Landing
Name><Side>and assigned Bank/Group <No>, Car
<No>

Missed Floor selection
after valid Pin Code
Entry/Card Swipe

Landing NA <Personnel Name> failed to select landing with Reason
Code 10

Denied Floor Access Landing NA <Personnel Name> failed to select <Landing
Name><Side>with Reason Code <no>

Pin Code Entry/Card
Swipe

Personnel NA <Personnel Name> is admitted at <name of the DEC>

Pin Code Entry/Card
Swipe

Personnel NA Rejected (Disabled)<Personnel Name> at <name of the
DEC>

Pin Code Entry/Card
Swipe

Personnel NA Rejected (Clearance)<Personnel Name> at <name of
the DEC>

Pin Code Entry/Card
Swipe

Personnel NA Rejected (Card disabled) <Personnel Name>at <name
of the DEC>

Card Swipe Personnel NA Access Denied -Card Unknown <Hex Value> at
<name of the DEC>



Category Object State Changes Message Description

Pin Code Entry/Card
Swipe

Personnel NA Rejected (Expired) <Personnel Name> at <name of the
DEC>

Card Swipe Personnel NA Rejected (Lost) <Personnel Name> at <name of the
DEC>

Pin Code Entry/Card
Swipe

Personnel NA Rejected (Stolen) <Personnel Name> at <name of the
DEC>

Pin Code Entry Personnel NA Unknown user pin entry occurred at <name of the DEC>



Locating OTIS Objects in the Journal
You can search for journal entries related to the OTIS Elevator.

To Locate Journal Entries for an OTIS Elevator Object

1. Right click anOTIS Elevator object in the Hardware Tree and select Find in Journal from the context menu.

TheQuery Parameters dialog box opens.

By default the query searches in the Journal for occurrences of the selected OTIS Elevator System object within the
last 7 days.

2. Click Run.

A Query - Journal for dialog box opens displaying the Journal Entries for the OTIS Elevator object.

Alternatively, you can click Modify to modify the query definition, adding or removing query parameters.

NOTE OTIS objects, such as the OTIS Clearance LandingMatrix, OTIS Default LandingMatrix,
OTIS Landing and, OTIS DEC, cannot be removed from the Journal Query due to a C•CURE
9000 limitation.



Locating OTIS Audit Log Entries
You can search for Audit Log Entries related to the OTIS Elevator objects.

To Locate Audit Log Entries for OTIS Elevator Objects

1. Select Options and Tools>Audit Log.

TheQuery parameters dialog box opens.

By default the query searches in the Audit Log for occurrences of the selected object within the last 7 days.

2. Click Run.

TheQuery - Audit Log opens displaying the Audit Log Entries for all OTIS Elevator objects.

Alternatively, you can click Modify to modify the query definition, adding or removing query parameters.
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Chapter 12 - Troubleshooting

This chapter helps to resolve problems youmay encounter with C•CURE 9000OTIS Elevator Integration.

In this chapter

Troubleshooting 136



Troubleshooting

Problem Manual action performed with same start and end time does not revert the action.

Solution Cancel the Manuel Action manually. For information see, Canceling Manual Actions on Page 128.

Problem Personnel details reported in monitoring station do not match the personnel details of the card
presented at DEC.

Solution Ensure card numbers are not duplicated. If two cards have the same number, change the number
of one of the cards.

NOTE This occurs when card formats share the same data length and both card formats have been assigned to
the DEC.
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Appendix A - Third-Party Copyright and Trademarks

In this appendix

Microsoft Limited Public License Information 138
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Microsoft Limited Public License Information

Microsoft Limited Public License Information
This software uses QueuedTaskedScheduler part of Microsoft Parallel Extensions Extra Library in
assembly

TSP.Enterprise.Server.ConcurrentTaskLibrary.dll under LPL 1.1 license.

_____________________________________________________________________________________

MICROSOFT LIMITED PUBLIC LICENSE version 1.1

This license governs use of codemarked as “sample” or “example” available on this web site without a
license agreement, as provided under the section above titled “

NOTICE SPECIFIC TOSOFTWARE AVAILABLE ON THIS WEB SITE.” If you use such code (the
“software”), you accept this license. If you do not accept the license, do not use the software.

1. Definitions
The terms “reproduce,” “reproduction,” “derivative works,” and “distribution” have the samemeaning here
as under U.S. copyright law.

A “contribution” is the original software, or any additions or changes to the software.
A “contributor” is any person that distributes its contribution under this license.
“Licensed patents” are a contributor’s patent claims that read directly on its contribution.

2. Grant of Rights
(A) Copyright Grant - Subject to the terms of this license, including the license conditions and limitations
in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free copyright license to
reproduce its contribution, prepare derivative works of its contribution, and distribute its contribution or
any derivative works that you create.
(B) Patent Grant - Subject to the terms of this license, including the license conditions and limitations in
section 3, each contributor grants you a non-exclusive, worldwide, royalty-free license under its licensed
patents to make, havemade, use, sell, offer for sale, import, and/or otherwise dispose of its contribution
in the software or derivative works of the contribution in the software.

3. Conditions and Limitations
(A) No Trademark License- This license does not grant you rights to use any contributors’ name, logo, or
trademarks.
(B) If you bring a patent claim against any contributor over patents that you claim are infringed by the
software, your patent license from such contributor to the software ends automatically.
(C) If you distribute any portion of the software, youmust retain all copyright, patent, trademark, and
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Microsoft Limited Public License Information

attribution notices that are present in the software.
(D) If you distribute any portion of the software in source code form, youmay do so only under this license
by including a complete copy of this license with your distribution. If you distribute any portion of the
software in compiled or object code form, youmay only do so under a license that complies with this
license. (E) The software is licensed “as-is.” You bear the risk of using it.
The contributors give no express warranties, guarantees or conditions. Youmay have additional
consumer rights under your local laws which this license cannot change.
To the extent permitted under your local laws, the contributors exclude the implied warranties of
merchantability, fitness for a particular purpose and non-infringement.
(F) Platform Limitation - The licenses granted in sections 2(A) and 2(B) extend only to the software or
derivative works that you create that run directly on aMicrosoft Windows operating system product,
Microsoft run-time technology (such as the .NET Framework or Silverlight), or Microsoft application
platform (such as Microsoft Office or Microsoft Dynamics).
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Clearance LandingMatrix 78
Default LandingMatrix 59
Elevator System 30
Landing 64
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Elevator System Editor 27
Landing dialog box 62
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